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About This Manual
The following instructions for using the DS2 Automated ELISA Processing System (DS2) are
included in this manual:


Installing the DS2



Configuring the DS2 hardware for specific application requirements



Creating or modifying assays using the DS2



Running assays by using worklists



Performing required preventive maintenance



Servicing the DS2
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Chapter 1 Overview
1.1 Introduction
The DS2 Automated ELISA Processing System is a computer-controlled microplate
processing system that fully automates the following steps of microplate ELISA assays:


Sample distribution



Reagent addition



Incubation



Plate washing



Signal detection

The DS2 is intended for use in clinical, research, and industrial laboratories.

Figure 1-1: The DS2 Automated ELISA Processing System (Cover Open)
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1.2 DS2 Specifications
DS2 Instrument Dimensions
Width

540 mm (21.3 inches)

Depth

680 mm (26.8 inches)

Height

660 mm (26.0 inches)

Weight

48 kg (106.0 lbs.)

Power Supply
Voltage

100-240 V auto-switching

Frequency

50/60 Hz

Power Consumption

≤ 360 VA

Reader Specifications
Dynamic Range

0.100 to 3.00 OD

Spectral Range

405 nm to 690 nm

Precision

<1% CV (<2.00 OD); <2% CV (2.00-3.00 OD)

Accuracy

± 0.005 OD or 2.5% (whichever is greatest)

Read Time

<30 sec (single wavelength)

Washer Specifications
Manifold Configuration

8-Way

Dispense Volume Range

50 to 1000 µL

Wash Buffers

2x2L

Input connector for external
clean fluid bottle provided

Clean fluid bottle must be provided (any size)

Waste Container

1 x 1.5 L

Residual Wash Volume

<3 µL with super sweep

2
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Incubator Specifications
Temperature Range

Ambient plus 4C up to 40C

Temperature Accuracy

± 1C at 370 C

Shaking

Independent linear motion 14-20 Hz periodic or
continuous

Instrument Capacity
Number of Plates

2

Number of Assays/Run

12

Number of Sample Tubes

100 (5 racks of 20)

Number of Reagents

10 x 15 mL tubes and
8 x 25 mL tubes (when using the Dynex workspace)

Number of
Standards/Controls

24 x 2 mL tubes (when using the Dynex workspace)

Number of Sample Tips

216

Number of Dilution Deep
Wells

96

Sample Tube Dimensions

10 to 16 mm external diameter
40 to 100 mm height

Number of Reagent Tips

20
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Sample Pipetting Specifications
Sample Tip Size

300 µL

Single-shot Sample
Pipetting Volume

10 to 250 µL

Time to Dispense
96 x 50 µL

<20 minutes

Single-shot Dispense
Precision

<3% CV (10 – 250 µL)

Reagent Pipetting Specifications
Reagent Tip Size

1300 µL

Reagent Pipetting Volume

20 to 1000 µL

Single Shot Dispense
Precision

<3% CV (20 – 1,000 µL)

4
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1.3 Description of Hardware Components
1.3.1 System Cover
The system cover encloses the workspace, the arm and the pipette module. The cover should
be closed during operation to prevent accidents.
CAUTION: The system cover prevents accidental interaction
with the arm.

To open the cover, lift the cover handle until the cover is in the upright position. To close the
cover, pull down on the cover handle until the cover is fully closed. The system cover will rest
on the side panels when it is completely closed.
CAUTION: Pinching hazard. Be sure that your hands and
fingers are clear of the cover when closing.

Cover
Handle

System Cover

Cover Resting
Point

Indicator Light

Power Switch

Figure 1-2: External Components of the DS2 System
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1.3.2 Workspace Components


X-Drive, Y-Drive and the Z-Drive



Reader Assembly (which contains the Incubation Chamber, Reading Optics (under the
Sample Tip Trays) and the Pipetting/Washing area (under the Sliding Cover)



Barcode Scanner



Wash Head
Incubation
Chamber

Reading
Optics

Pipetting/
Washing Area

Wash Head

Incubator
Door Lever

Barcode
Scanner

Sliding Cover

Figure 1-3: Workspace Components of the DS2 System
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1.3.3 Microplate Incubation Chamber
The incubation chamber can hold up to two microplates during a run. During an incubation
step, the reader sliding cover and incubator door are closed to ensure proper temperature
equilibration.

1.3.4 Barcode Scanner
The barcode scanner reads barcode labels on the sample tubes as well as the positioning
barcode labels located on the sample tube racks.
The barcode scanner is an IEC60825-1+A2:2001 Class 1 Laser Product that complies with 21
CFR1040.10 and 1040.11 except for deviations pursuant to Laser Notice 50 dated 7-26-01.
CAUTION: The barcode scanner has a maximum radiated power output of
1.0 milliwatt. Do not stare into the beam of the barcode scanner without
appropriate protective equipment (e.g. protective glasses). Obey the
warning label (shown below) that is on the front of the barcode scanner.

1.3.5 Pipette Module
The Pipette Module travels in the x-, y-, and z- directions to pipette samples, controls and
standards, dispense reagents, and to perform dilutions. The Pipette Module is also used to
slide the cover to the Incubation Chamber open and close, as well as to pick up and eject the
plate Wash Head Assembly.
The pipette module has the following sub-components and functions:
Component

Function(s)

Pipetting
(liquid level
detection)

Pipettes samples, standards and controls (using
disposable sample pipette tips) and reagents (using
disposable reagent pipette tips).
Liquid level detection is performed by sensing
pressure changes.

Tip Detection

Verifies that a tip has been picked up or ejected.

Wash Head
Detection

Verifies that wash head assembly has been picked up
or ejected.
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The pipetting system of the DS2 Automated ELISA System includes ESP™ (Electronic
Signature Pipetting) software. ESP™ software automatically detects pipetting inaccuracies
caused by bubbles, foam, and mucus.

1.3.6 Wash Head Assembly
The DS2 uses a modular Wash Head Assembly that is stored in the front left corner of the
workspace. The wash head assembly is picked up by the pipetting arm to perform wash
operations. The Wash Head Assembly is designed to wash 8 well strips of a full or partial 8 x
12 microplate.

Pipetting Arm

Wash Head
Assembly

Figure 1-4: Pipetting Arm Picking Up the Wash Head Assembly
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1.3.7 Wash Head
The Wash Head portion of the Wash Head Assembly contains two sets of pins. The shorter
pins (the dispense pins) dispense fluid and the longer pins (the aspirate pins) aspirate fluid.
The aspirate pins and the dispense pins are closely spaced so that fluid can be aspirated from
and dispensed into wells of a microplate at the same time.
During operation, the wash head assembly is automatically lowered to insert the pins into the
microplate wells or raised to remove the pins from the wells. Lowering the wash head
assembly allows the aspiration of the well contents, or performing a wash cycle at the well
bottom. Raising the wash head assembly allows the movement of the wash head to another
column for filling or washing.

Aspirate Pin
Dispense Pin

Aspirate Line

Dispense
Line

Figure 1-5: Wash Head with Wash Pins
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1.3.8 Wash Buffer Containers
Different wash buffers may be placed in the two wash buffer containers (A and B) located at
the front left of the instrument.
The maximum capacity of the wash buffer containers is 2 L. The wash buffer container must
have a minimum of 500 mL of fluid for a wash operation to take place.

Quick
Disconnect
Fitting

Float Switch
Connector

Wash Buffer
Container A

Figure 1-6: Wash Buffer Container A
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1.3.9 Wash Head Cleaning Fluid Container (Container C)
Distilled or deionized water may be used to clean the wash head after plate washing is
complete. The user must program this step into the assay using the Assay Editor. A user
supplied bottle (Container C) is attached to the rear of the DS2 using the supplied tubing. The
supplied tubing is attached to the Quick Disconnect valve located at the right rear of the DS2.

Wash Head
Cleaning Fluid
Container C

Quick
Disconnect

Container C Connection
Tubing

Figure 1-7: Wash Head Cleaning Fluid Container C
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1.3.10

Waste Containers

Fluid that is used during wash operations is collected in the Liquid Waste Container. Used
sample and reagent pipette tips are ejected into the Tip Waste Container. Both waste
containers are located at the front of the instrument.

Float Switch
Connection
(level sensor)

Tip Waste
Container

Quick Disconnect
Fittings

Waste Cap

Liquid Waste
Container

Figure 1-8: Waste Containers

The Liquid Waste Container holds up to two 2 L of waste. A Waste Fluid Level Sensor alerts
the operator when the Liquid Waste Container is full and should be emptied.
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1.3.11

Absorbance Module

The Absorbance Module measures the optical density (OD) of the microplate wells. OD is
also known as absorbance. The wavelength(s) at which the optical density is measured is
specified when programming the assay.

1.3.12

Single and Dual Wavelength Modes

The DS2 Reader is able to take readings in two different wavelength modes:


Single - using one analytical test wavelength



Dual - using one reference wavelength and one analytical test wavelength

The single wavelength mode is sufficient for most applications.
1.3.12.1 Blanking
The Reader allows subtraction of a reference value from well ODs. Air is automatically used
as a reference, but the absorbance of a reagent solution can also be subtracted from the test
result. Blank wells may be single wells or an average of multiple wells.
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1.4 Software Description
DS-Matrix software (also known as Matrix) is used to control the DS2 Automated ELISA
Processing System. The software automates the sample distribution, incubation, reagent
addition, and washing and detection steps of assays as defined by the user. The DS-Matrix
software also provides the user interface for configuration of the DS2 and management of
consumables.
The Matrix software includes assay definition options that allow the user to customize assay
parameters, assay steps, OD reading settings, result calculations, quality control checks, and
report formats.
Additional information about the software can be found in the DS2 Online Help, which is
accessible from the Help menu.

14
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1.5 Software Functions
1.5.1 DS2 Configuration
The following DS2 System parameters can be configured from the Tools menu: database
maintenance, pipetting options, OD read limits, system configuration, Levey-Jennings assay
parameters, absorbance filter selection, and user notifications.

1.5.2 Consumables Definitions
The DS-Matrix software stores parameters for all consumables and fluids used on the DS2 in
a database. A consumable or fluid must be defined in the database before it can be selected for
use in an assay.
The parameters for fluids and consumables that are stored in the database are summarized
below:
Consumable

Parameters

Bottles

Dimensions, capacity, and shape of reagent
and standard/control bottles, sample tubes,
reagent tubes, microtiter plates, and deep well
strips

Plates

Type, dimensions, well characteristics

Neat Fluids

Fluid name and type, pipetting profile, load
settings (location, bottle type).

(Sample and
Reagent Fluids)
Wash Fluids

Fluid name and load position

Tips

Length, capacity, and maximum fill volume

1.5.3 Assay Programming
The Assay Editor screen allows the user to program the sequence of pipetting, incubation,
dispensing, washing, and reading operations performed on samples. Data reduction and
reporting are also programmed using the Assay Editor screen.

1.5.4 Worklist Creation
The worklist defines the sample ID which corresponds to each sample tube and the assay(s) to
be run on each sample tube. A worklist can include information for up to four microplates.
More than one assay can be performed on a plate if the assays have the same incubation,
washing, reading, and shaking specifications.



Note: An assay must be created before it can be assigned to a worklist.
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1.5.5 Worklist Execution
Once a worklist is created, the operator is prompted to load any microplates and consumables
that are required at the beginning of the run.

1.5.6 Data Analysis
The Optical Density results for each sample ID in the worklist are analyzed according to the
criteria specified in the assay.

1.5.7 Results Reporting
The run report may be viewed when the assay is complete.

16
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Chapter 2 Safety
2.1 Warning Labels
The DS2 Automated ELISA System and its components contain labels that warn the user of a
hazard or an electrical connection. The description of the labels is described below. Potential
personal injury to the operator or damage the DS2 can result if the labels are not followed.
Label

Description
Alternating current is present
Caution symbol. Refer to the
Routine Maintenance chapter

Caution, motion hazard

Caution, pinching or mechanical hazard

Caution, hot surface

Laser radiation – Do not stare into beam

Protective conductor terminal

Earth (ground) terminal
Caution, risk of electric shock

Caution, biohazard
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2.2 Warnings and Safety Precautions
The following information aids in the safe and efficient use of the DS2.
In addition to the warning labels and other cautions previously described in
this manual, consider the following:
1. Use of this instrument in a dry environment, especially if synthetic materials are present
(synthetic clothing, carpets etc.) may cause damaging static discharges that may cause
erroneous results.
2. It is the user’s responsibility to ensure that a compatible electromagnetic environment for
the equipment can be maintained in order that the device will perform as intended. The
electromagnetic environment should be evaluated prior to operation of the DS2.
3. Do not use this device in close proximity to sources of strong electromagnetic radiation
(e.g. unshielded intentional RF sources), as these may interfere with the proper
operation.
4. If the DS2 is used in an unspecified manner, the protection provided by the equipment
may be impaired.
5. Do not position the DS2 so that it is difficult to disconnect the DS2 from the power supply.
6. Do not use decontamination or cleaning agents that could cause a HAZARD as a result
of reaction with parts of the equipment or with material contained in it. 70% isopropyl or
ethyl alcohol as well as laboratory disinfectants containing quaternary ammonium
sulfates are approved for use to clean and disinfect the DS2. Please contact your
instrument provider if there is any doubt about the compatibility of decontamination or
cleaning agents with the DS2.
7. The DS2 is tested and compliant to IEC 61326-1:2005 & IEC 61326-2-6:2005 standard
for Electrical equipment for measurement, control and laboratory use with particular
requirements for in-vitro diagnostic devices
8. All parts and accessories of DS2 are required to be examined or supplied only by the
manufacturer or its partner.
9. This equipment has been designed and tested to CISPR11, Class A. In a domestic
environment it may cause radio interference, in which case you may need to take
measures to mitigate the interference.
10. Appropriate precautions must be taken when working with biohazards. Technicians must
be trained in the safe handling and clean up of potential blood borne pathogens.
Universal precautions, appropriate hygiene, and decontamination of surfaces are
recommended. Consult the reagent kit manufacturer for precautions on handling
potentially hazardous substances.
11. Appropriate personal safety precautions must be made when opening and closing the
DS2 cover. A gas spring holds the tension to keep the cover open. The DS2 cover should
be able to be opened 8 inches (approximately 203mm) without falling. If the cover drops
instantly above this height then the gas spring should be replaced. The cover may creep
down slowly from this point due to the nature of gas springs and this is acceptable. Gas
18
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springs will inevitably lose pressure depending on frequency of use, so it is important for
the user to take note if the cover begins to give way over time and notify the service
provider of this circumstance. As a safety precaution, the user is responsible to do this
check monthly.
12. When the cover is up and the run has started, do not encroach upon the work area
unless prompted by the software for user input of materials or manual intervention.
13. Attend to error messages when the system prompts and stops. These messages indicate
a need for user action.
14. Sample tubes must be pushed down in the sample racks to prevent the pipette module
from being obstructed.
15. Place the sample racks securely onto the DS2. Push the rack firmly towards the back of
the DS2 so that the rack clicks in place.
16. Periodically inspect the sample rack springs to ensure proper tube alignment. Replace
the springs as necessary.
17. Barcode quality is critical to successful sample tube barcode scanning. Scanning is in
accordance with ASTM E1466-92 defining barcode quality, position, and orientation of
barcode labels. The use of non-standard barcodes or barcodes with poor print quality
may be problematic. Barcode labels should be applied using a vertical orientation. The
barcode label should be oriented so that it faces out of the opening in the sample rack.
18. Periodic back up of assay and data files is recommended. Copy the files to a disk for
storage or archive the data on a secure server
19. Changes made to assay files may impact the suitability and plotting of data using the
Levey-Jennings control-charting feature.
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Chapter 3 Installation
3.1 Unpacking
3.1.1 Packing List for DS2 Installation
(DYNEX Part Number 62000)
P/N

Description

Qty

13500010

DS2 Automated Instrument

1

50600167

USB Cable

1

N/A

Power Cord (dependent upon order request
configuration)

1

352101800

Cleaning Wire, 0.018 “ (Dispense)

2

352104000

Cleaning Wire, 0.040 “ (Aspirate)

2

62800-113

CD Containing Matrix Software Setup
(numbers after the hyphen may change
depending on the current version)

1

62810-101

Arm Calibration Tool CD (numbers after the
hyphen may change depending on the
current version)

1

91000200

DS2 Operator’s Manual (this document)

1

92000040

CD Containing DS2 Operator’s Manual

1

N/A

Instrument Configuration Report (Check List)

1

13500560

Wash Buffer Container

2

13500430

Liquid Waste Container

1

13500770

Tip Waste Container

1

24900065

Reagent Rack

2

13500501

Sample Rack

5

13500100

8-Way Wash Head Assembly

1

24900081

Purge Tray, Wash Head

1

22500810

Transit Bracket

1

DS2FIX017

Calibration Tool

1

DS2FIX029

Calibration Collar

1

65910

Sample Tips (Four Racks of 108)

1
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65921 or
65920 (Partial)

Reagent Tips (One Rack of 108)
Part numbers have equivalent function and
either may be used and packed at the
discretion of Dynex Technologies.

1

(Standard for Part No. 65921: Four Racks)

62910 (Partial)

Deep Well Strips (Sample Pack: 12 Strips)

1

(Standard for Part No. 62910: 250 Strips)

62920

Reagent Tubes, 25 mL (Pack of 10)

1

62930

Reagent Tubes, 15 mL (Pack of 10)

1

65940

Control Vials (Pack of 33)

1

394000100

Purge Tray, Wash Calibration

5

42000810

Hex Key, 2mm

1

816400700

Tubing, 3mm x 5mm

1 (Meter)

43000491

Elbow Fitting

1

DSFIX044

DS2 Calibration Plate

1

42000070

Hex Key, 2.5mm

1

42000830

Hex Key, 4mm

1

9055720009 Warranty Card

1

N/A

Declaration of Conformity

1

N/A

Customer Installation Report

1

22
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3.1.2 Unpacking the Components



IMPORTANT: These installation procedures are intended for trained personnel

Unpacking the Components:
1. Cut open the lid of the cardboard carton containing the DS2.
2. Remove the Accessory box and packing materials, including the foam inserts and
wooden supports from the box.
3. Obtain a wheeled cart or lift capable of holding the weight of the DS2. Remove the crate
clips holding the top of the carton to the bottom of the carton. The clips can be removed
by squeezing the two white grips together and lifting upward. They are located around
the base of the box. Once all the clips are removed, lift the top of the cardboard carton
off the base. Unwrap the DS2 from the plastic bag and lift the DS2 onto the cart.
CAUTION: The contents of the crate are heavy. Two people are required to
lift the DS2 safely. The DS2 should be lifted from the bottom of the
instrument. Do not use the cover handle or the plastic molded sides to lift the
DS2.
4. Place the DS2 near the bench or table where it will be located.
5. Examine the packaging to verify that all of the materials listed in the packing list have
been removed. Store the packaging material for future use.
6. Inspect the DS2 and its components for damage. If damage is observed, contact your
shipper or service representative.

Positioning the Instrument:
1. Determine where the DS2 will be located. The bench space requirement for the DS2
Automated ELISA System is approximately:
54 cm (21.3 inches) wide
75 cm (29.5 inches) deep
110 cm (43.3 inches) high, with the cover open
2. The DS2 must be positioned on a sturdy level surface that does not support other
devices that produce vibration (centrifuges, shaker bath, etc.).
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3. If the instrument may be used with the cover up, avoid positions that allow the instrument
to be subjected to direct sunlight or strong internal lighting. This will interfere with tip
sensing and barcode reading.
4. If a Wash Head Cleaning Fluid Container C will not be used, there must be at least 10 cm
(3.9 inches) of space at the rear of the DS2 to allow for sufficient ventilation. If a Wash
Head Cleaning Fluid Container C will be attached, there must be at least 25 cm (9.75
inches) clearance at the rear of the DS2.

24
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3.2 Connecting the Computer System
3.2.1 Computer Minimum Specifications
The computer system that is used for operation of the DS2 Automated ELISA
Processing System must meet the following minimum specifications:
1. Intel Core/Core2/Pentium 4/Celeron family or compatible processor recommended
2. 2 GHz or higher processor clock speed recommended; 1.8 GHz minimum required
3. 10 GB hard drive with at least 100 MB of free space
4. Microsoft® Windows® XP Professional operating system with Service Pack 3 or
Microsoft® Windows® 7 Professional operating system (32-bit x86).
5. Microsoft® Windows® compatible display adapter (card or built into motherboard) with
32-bit color (Highest setting) at 1024x768 or more resolution
6. 1 gigabytes (GB) of random-access memory (RAM) required for Windows XP computers,
4 gigabyte (GB) of random-access memory (RAM) for Windows 7 computers.
7. One unused USB port is required for connecting the computer to the DS2 Automated
ELISA System
8. Mouse or other pointing device supported by Windows®
9. Microsoft® Windows® compatible CD-ROM or DVD Drive
10. Microsoft® Windows® compatible printer and sound card.
11. Network/LAN connection, 10/100 network interface (optional)
12. Serial Port (for LIS-interfacing)

3.2.2 Connecting the Computer
Connecting the Computer System:
1. Place the computer, keyboard, monitor, and printer next to the DS2.
2. Plug the USB communication cable into an unused USB port on the computer.



Note: Refer to the instructions accompanying the computer for the location of the
ports and for information on connecting components.

3. Plug the other end of the USB communication cable into the USB port on the right rear
side of the instrument.
4. Connect the keyboard, monitor, and printer cables to the computer.

DS2® System Operator’s Manual

25

Chapter 3 Installation

5. Connect the power cords to the computer, monitor, and printer.

USB Port

Cooling
Fan
Power Cord
Connector

Figure 3-1: View of the Rear of the DS2 Automated ELISA System
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3.3 Connecting the DS2 Power Cord
The power cord connection to the DS2 is located in the rear of the system.



Note: Depending upon local electrical codes and electrical service quality, an
optional uninterruptible power supply (UPS) may be required in your laboratory.
The use of a UPS is optional but strongly recommended. A UPS can be purchased
from an electronics supply house.

CAUTION: The DS2 System must be connected to a properly grounded
electrical outlet. Obtain assistance from a qualified electrician to verify that
your electrical outlet is properly grounded.
Before connecting the power cable, be sure that the components have been
connected to each other as outlined in the previous section.

Connecting the Power Cord:
1. Plug the power cord into the connector at the rear of the instrument (Error! Reference
source not found.Figure 3-1).
2. Connect the other end of the power cord to the laboratory electrical supply outlet.

DS2® System Operator’s Manual

27

Chapter 3 Installation

3.4 Installation of DS-Matrix™ Software
Installation Instructions
1. Insert the installation CD into the CD ROM. The InstallShield® Wizard for Matrix starts
automatically.



Note: If the InstallShield wizard does not start automatically, select Start and then
Run from the Windows task bar.
In the Run dialog box, browse to the CD ROM drive, select setup.exe, click Open,
and then click OK.

2. Click Next and follow the wizard instructions.
3. InstallShield Wizard Complete is displayed when the installation is done. Click Finish
and remove the installation CD from the CD ROM.
4. Access Matrix software from the Windows program group: Dynex Technologies > DSMatrix > DS-Matrix.



Note: A printer driver must be installed for run reports to be viewed using the
Matrix software.

3.4.1 Creating a Shortcut on the Desktop
A shortcut should automatically be created during installation. In the event it is not, follow the
instructions below:
To place a Matrix shortcut icon on your computer desktop:
1. Open Microsoft Windows Explorer.
2. Locate the Matrix program:
C:\Program Files\Dynex Technologies\DS-Matrix.
3. Click MatrixApp (.exe) to highlight it.
4. Select File > Create Shortcut from the Windows menu toolbar.
5. Resize the window so the desktop and window are both visible.
6. Drag the shortcut to matrixapp.exe to the desktop.
7. Close Microsoft Windows Explorer.

28
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3.5 Starting the System
CAUTION: Before starting the system, be sure that all racks are properly
seated and that the lids are removed from all tubes, plates, and sample tip
racks.
CAUTION: Power is on to the system whenever the blue indicator on the DS2
is illuminated.



Note: The DS2 and DS-Matrix software must be shut-down once every twenty-four
hours to ensure proper DS2 performance.

Starting the DS2 System
1. Power on the DS2 System.
2. If not powered on, power ON the computer, monitor, and printer.
3. A “Found New Hardware” wizard may appear as the computer recognizes the DS2. The
new hardware wizard must be completed prior to attempting to connect to the DS2 via
the DS-Matrix software.
4. Double-click the DS- Matrix shortcut icon to present the Run Mode dialog box.

Figure 3-2: Matrix DS2 Run Mode Dialog Box
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Select the desired language from the drop down list.
5. Ensure the desired workspace configuration is selected. If the Current Workspace is not
the desired workspace configuration, click the Change Configuration button.
a. The Choose Configuration To Use dialog box appears. Select the desired
Workspace Definition from the drop down list and click OK.

Figure 3-3: Choose Configuration Dialog Box
6. Select the run mode. Select Normal Mode to operate the DS2 System. Select
Simulation Mode to operate the software without connecting to the DS2.
7. The DS2 performs a series of self tests before the instrument is available for running an
assay (Section 3.6).

30
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3.6 Initialization
The DS2 will perform a series of initializations before it is ready to start a run, including
picking up the wash head assembly, opening and closing the incubator door, and moving the
microplate carrier to and from the incubation and reader chambers.

CAUTION: Do not interrupt the DS2 while it is performing the initialization
procedure.

A self test report is displayed following the initialization procedure. The self test report must
be closed for the DS-Matrix software to finish its initialization. Following initialization, the
main DS-Matrix screen is displayed.
Timeline
Toolbar

Incubator
Temperature

Figure 3-4: Main Runtime Screen

The Timeline toolbar contains icons for starting and stopping the run, changing the display,
and setting run options. Certain functions may not be available depending upon the run status.
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Chapter 4 Setting System Parameters
4.1 Overview
The DS2 Matrix software contains a set of system parameters that are set globally for all
assays. These parameters can be found in the Tools menu, and are listed below:


Database Maintenance



System Configuration



User Notification



Absorbance Filter



Import/Export



Reset Auto Recovery



View Event Log



Levey-Jennings Criteria



ESP Calibration



Fluid Level Tracking
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4.2 Database Maintenance
The DS-Matrix software database includes a description of all consumables (plates, racks, and
tips) and fluids (reagent controls, standards, wash buffers, stop solutions, substrates, etc.) used
on the DS2. A consumable or fluid must be defined in the database in order for it to be
available for selection from a drop-down list when creating or editing an assay.
Editing Parameters for Consumables



Note: Factory provided settings are read-only and cannot be modified. Settings
can be duplicated by copying a consumable or fluid and saving the settings under
a different name.



IMPORTANT: It is the burden of the user to perform appropriate validation of any
consumable parameters to ensure proper assay performance. Factory defined
consumable settings will not necessarily work with all consumables.

See Appendix E for defining a new tube and Appendix F for defining a new plate.
1. Select Tools > Database Maintenance from the menu bar.
2. Select the appropriate consumable category using the drop-down menu to present the
Database Maintenance Screen (Figure 4-1). The Database Types are:
BottleType, PlateType, NeatFluid
WasherFluid, TipType, RackType, Barcode Scripts

Figure 4-1: Database Maintenance Screen
34
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3. To update an existing definition, highlight the desired consumable and click the Edit
button (Figure 4-2). Factory defined consumables are read-only and cannot be edited.
4. Definitions may be changed by editing the values in the text boxes.
5. Click Save to save the new parameters.

Delete

Add

Edit

Copy

Exit

Help

Figure 4-2: Database Maintenance Screen – Button Definitions
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Adding a Consumable
1. Click on the Add button (Figure 4-2), enter the consumable name and click OK.
a. Consumables from the same assay should have a similar beginning to the name
so that they are grouped together in the drop down list. This will make fluids
easier to locate when writing assays. For example:
1. Lyme Substrate
2. Lyme Positive Control
3. Lyme Cutoff Calibrator
b. If fluids are used universally across many assays they may be given a generic
name, such as the name of the kit manufacturer. For example:
1. Dynex Wash Buffer
2. Dynex Stop Solution
3. Dynex Substrate Solution
c. Once the consumable name is entered, the data entry window opens (Figure 4-3
presents an example). Enter the required parameters.

Figure 4-3: Neat Fluid Addition Screen
3. Click Save. The new consumable will be added to the database for selection from the
drop down list.
4. To edit a consumable, highlight the desired consumable and click the Edit button (Figure
4-1). Change the desired parameters, and save the changes.
5. To copy a consumable, click the Copy button (Figure 4-1). Copied consumables must be
saved under a different name.
6. When finished editing the consumables database, click the EXIT button (Figure 4-1).
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4.3 System Configuration
System configuration parameters are universal for every assay that is run on the DS2.
Changing any of the parameters on the System Configuration screen will update the
parameters used for every assay.
Pipetting
Options

Container
Types

Mixing
Parameters

Figure 4-4: System Configuration Fluids Screen
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Defining System Configuration Fluids Parameters
1. Select Tools > System Configuration from the main Matrix screen. The window opens
to the Fluids tab.
2. The Deep Well Strip type and Sample Tube type that will be used on the system are set
to the default types. The Deep Well Strip type should not be changed by the user unless
instructed to do so by Dynex personnel.
3. Mix Volume (μL) is the amount of fluid that will be aspirated and dispensed into a deep
well strip to mix the sample during dilution steps. If using a smaller dilution volume, the
mix volume should be changed accordingly to avoid bubbles. Changing this setting will
change the mix volume for all assays.
4. Acceptable error for fluid volume levels (μL) provides a range of tolerance for volume
when performing fluid level tracking on a new bottle type. For example if the maximum
volume in the bottle definition is 2000 µL, then a value of 5 in the Acceptable Error for
fluid volume levels text box indicates that the software indicates the expected weight
range as within ± 5% of the expected volume.
5. By enabling the Clot Detection check box, the system will alert the user if a clot (which
prevents aspiration) is detected. Clot detection will not alert the user if subtle fluid
aspiration changes occur.
6.

Track Fluids controls how Matrix treats live bottle information. By enabling Track
Fluids, the software will remember rack locations already assigned to fluids when
scheduling. If this option is disabled, a fluid location will be free once the required volume
for the fluid reaches 0ul.

7. Share Fluids Across Worklists is intended to prevent mixing fluids from different kit
lots. By enabling Share Fluids Across Worklists, the system will allow fluids used in
previous worklists to be used on the current worklist. If more fluid is required to run the
new worklist, the software will ask the user to add more fluid to the bottle in its current
location. If the option is disabled, the software will always request new fluids for a
worklist. The software will not use fluids already loaded on the system and will not
request users to add fluid to existing bottles. New bottles will be used.
8. Dynamic Fluid Tracking for Controls, Standards and Samples is intended to prevent
false level detects when using bubbly fluids. When this option is disabled (unchecked)
the system will level detect in a control, standard, or sample each time a new pipette tip is
used. If this option is enabled (checked), the system will only level detect each
fluid once per worklist.
9. Enable the Save all ESP (Electronic Signature Pipetting) parameters option to create an
ESP calibration profile for each fluid in the system. This option allows users with
engineering capabilities to monitor fluid aspirations and dispenses for uniformity.
Statistics generated by this feature can only be viewed in engineering mode.
10. The ESP score is also used in engineering mode. The ESP score defines the passing
calibration score for all fluids when monitoring the ESP calibration data. Ramp times,
pipetting speeds and pressures are all taken into account when calculating the ESP
score.
38
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Specifying Pipetting Options
1. The aspirate and dispense profiles specify the rate at which the samples are aspirated or
dispensed from the pipette tip. Only sample aspirate and dispense speeds are specified
in system configuration on the fluids tab. The higher the number, the faster the rate of the
aspiration or dispense, therefore use caution when setting these profiles. At a higher
velocity bubbles or aerosols may occur which can affect the accuracy and precision of an
assay. These settings are global and will be applied to all sample types used on the
DS2.



Note: For any pipetting device, fluid properties such as viscosity and surface
tension can influence the aspirate and dispense accuracy. DYNEX
Technologies calibrates and verifies all pipettes using an aqueous calibration
fluid which, when used with a special calibration apparatus, provides
traceability to a NIST standard and gravimetric method.
It is the burden of the user to perform the validation studies necessary to
assure proper assay performance.

2. Serial vs. Parallel Pipetting: If the same sample is used on multiple plates or within
multiple assays on the same plate, the user can choose to pipette the samples serially or
in parallel. Serial pipetting pipettes all samples and controls in the specified well order,
starting with well A1 and pipetting down columns to well H12 (unless the pipetting order
dictates differently (see the pipetting operation section of the assay editor section). The
“Parallel Pipette, across assays only” option will pipette a sample into all assigned wells
on plate 1 before pipetting the next sample. Once plate 1 has been completely pipetted,
the samples will be pipetted in the same manner on Plate 2. The “Parallel Pipette, across
plates and assays” option will pipette a sample into all assigned wells on Plate 1 and
Plate 2 prior to pipetting the next sample. Matrix selects serial pipetting by default.
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Defining System Configuration Operations Parameters:

Figure 4-5: System Configuration - Operations Tab
1. Enable the Duration Learn feature by checking the check box.
a. When the Duration Learn feature is enabled (the check box is checked), the DS2
will collect timing information on individual runs in order to improve timing
estimates when scheduling assay steps.
b. Duration Learn should not be used during assay development and validation.
Duration Learn should only be used once assays are in their final configuration.

40
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2. Enable Auto Template Reduction by checking the check box. Auto Template
Reduction allows the user to define control or calibrator wells at the end of the assay
template and have those controls or calibrators pipetted following the last specimen well,
instead of being pipetted into the wells exactly as depicted in the template. For an
example, please refer to the assay template pictured in Figure 4-6.

Figure 4-6: Microplate Pipetting Template with Controls
In this example, we assume that 3 samples will be run on this assay in the worklist
defined by the user. If Auto Template Reduction is enabled, the wells NC2 and PC2
would be pipetted into the first available wells (A2 and B2). If Auto Template
Reduction is not enabled, the NC2 and PC2 wells will be pipetted in G12 and H12. All
other wells in column 12 will remain empty, as will wells in columns 2-11.
3. Enable the Enable Boolean Function Assays option by checking the check box. This
option enables spreadsheet functionality necessary to perform data reduction for certain
unique assays. This is a custom functionality option designed for use with specific
assays. Contact Dynex Technologies Technical Support for more information on this
functionality.
4. Enable the Debug Log by checking the check box.
a. The Debug Log is used to determine the root cause of a system crash. Dynex
recommends that this feature be enabled (check box is checked) so better
technical assistance can be provided.
DS2® System Operator’s Manual
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Defining System Configuration Data Read Limits:

OD Limit

Numerical
Conversion

Figure 4-7: Over / Under OD Conversion
1. Set the OD OVER/UNDER Range for plate data results. The OVER/UNDER Range
indicates the highest allowable OD to be reported. The reader is accurate between 0 to 3
OD (2.5 OD if reading for a quantitative assay). If a value is over the specified over
range or below 0, no result for the sample will be reported and “****” will appear as the
OD result for the sample.
2. When the OVER/UNDER Conversion option is enabled (the check box is checked), any
values over or under the specified detection limit will be changed to reflect the values
specified in the OVER Value and UNDER Value text boxes. Therefore, an OD result will
appear on the report and a result can be calculated for the sample. The values in the
Over Value and Under Value text boxes are user configurable.
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Defining System Configuration Laboratory Information:

Enter Laboratory
Information

Figure 4-8: Laboratory Information Entry
1. Enter the desired laboratory information into the designated information fields. This
information may be automatically inserted into assay reports if the user has configured
the report to contain laboratory information.
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Defining System Barcodes:

Figure 4-9: Barcode Options Tab

The DS2 Barcode Scanner is able to read 6 different symbologies (Figure 4-9).
1. Enable the check box Use Check Digit if the last numerical digit is used to verify that the
rest of the barcode is correct. If enabled, the Check Digit will not appear as part of the
sample ID. If disabled the last number in the bar code will be part of the sample ID.
2. Enable the check box Use Leading Zero if the first numeric digit in the bar code is a 0.
3. The Codabar barcode symbology drop-down menu becomes available if Use Check
Digit is enabled. The options listed in the menu are Modulo 10, Modulo 16, and Modulo
7, which are calculations used to produce the Check Digit number.
4. The IATA barcode symbology drop-down menu becomes available if the Use Check
Digit is enabled. The options listed in the menu are Coupon+Form+Serial, Form+Serial,
and All Data, which are formulas used to produce the Check Digit number.
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Defining System Configuration, Self Test Report Options:

Figure 4-10: System Configuration: Self Test Report Options Tab
1. If the Generate self test report option is enabled, the system will generate a self test
report during system start-up. Dynex recommends that this option be enabled.
2. If the Automatically save self test report check box is enabled, the user may select the
format for which the report should be saved (either Excel® or PDF) and the location the
file should be saved in the Save directory. The default location to store the file is the selftest report folder in the DS-Matrix directory as shown above. Dynex recommends that
you do not change the default location.
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Defining System Configuration, Database Backup Options:

Figure 4-11: System Configuration: Database Backup Options Tab
1. Set the Backup Frequency.
a. Select the desired database backup frequency from the drop down list.
b. The default location for database backup files is: C:\Program Files\Dynex
Technologies\DS-Matrix\DatabaseBackup. Dynex recommend that you do not
change the default file location.
c. The user may specify the date and time when the specified backup frequency
should begin.
d. The Matrix software will display when the last back-up took place and when the
next back-up will take place
2. The user may choose to Restore a database from the Database Backup Options tab.
a. Click on the

button to browse the desired backup database.

b. Click Restore to update the current database display with the selected database
information. Any information in the current working database will be over-written
and any changes made since the most recent back-up was performed will be lost.
3. The user should empty the database backup folder, with the exception of one or two early
clean databases and some of the more recent databases, on a monthly basis to save
space.
46
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Defining System Configuration, LIS Options:

Figure 4-12: System Configuration, LIS Options Tab
3. When the LIS-Link software is installed the Enable LIS Support checkbox will be active.
4. Click the Enable LIS Support checkbox to activate the LIS option within Matrix.
5. The LIS Service Information will automatically fill in when connectivity is achieved.
6. Enable the Reprocessing and Export Options as desired.
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4.4 DS-Matrix User Notification
DS-Matrix software can be configured to send E-mail to a specified E-mail address when
system error conditions occur.



Note: An E-mail server and internet connection are required.

Configuring the DS-Matrix User Notification
1. Click on Tools > User Notification from the main Matrix menu toolbar. The following
screen will be displayed:

Sender
E-mail
Address

Figure 4-13: User Notification Options Dialog Box
2. Click on the Setup tab. In the To textbox, type in the E-mail address for the recipient of
the user notification E-mail sent from the DS2 Matrix software.
3. In the From textbox, type in the E-mail address of the sender (for example the E-mail
address of the lab manager).
4. In the SMTP Server textbox, type in the SMTP server for the sender’s E-mail address.
5. Click on the Save button to save these parameters, or click the Send Test E-Mail button
to test the settings.
6. Click on the Manual tab to send e-mails manually. The screen below will be displayed:
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E-mail
Addresses

E-mail
Message
Body

Figure 4-14: E-mail Setup Screen for User Notification
7. Fill in the recipient’s email address and the sender’s E-mail address, along with the Email text.
8. Click the Send E-Mail button to send the e-mail.
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4.5 Absorbance Filter
Four standard absorbance filters are included with the DS2. The wavelengths of these filters
are 405, 450, 490, and 620 nm. The user may order a custom filter set specific to their
assay(s) by purchasing them from the supplier. Up to 6 filters may be installed in the DS2
filter wheel.



Note: It is important that the filter wavelength matches the position of the filter that
is installed, or the assay results will be affected.

Editing Absorbance Filter Definitions:
1. Click on Tools > Absorbance Filter from the main Matrix menu toolbar.
2. Edit the wavelength values for Filters 1-6.



Note: The 405 nm filter must be in Position 1 of the filter wheel or the self-test will
fail.

3. If no filter is installed at any position, list the wavelength value as “0” for this position.
4. Click OK when finished to save changes made. At this point the system will self test the
reader and the changes will be saved. To exit without saving changes, click Cancel.

Filter
Wavelength
Value

Figure 4-15: Absorbance Filter Designation
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4.6 Import/Export
Assay and OD data files may be imported or exported for use in other DS2 instruments or in
other software applications.
Exporting an Assay File
1. Click on the Export radio button.
2. Enable the Assay checkbox. Highlight the desired assay.
3. The Assay File Filter will sort the assay names displayed by name, category, or Last
Edited Date.
4. Click on
and browse to the desired file location. Enter a file name. An *.xml
extension will be assigned to the file when it is saved.
5. Click Export.



Note: Assay files cannot be opened in document or spreadsheet applications. DSMatrix assays can only be imported back into DS-Matrix.

Sort Assay Files

Click to
Browse

Click to Export File

Figure 4-16: Import/Export Dialog Screen (export options)

DS2® System Operator’s Manual

51

Chapter 4 Setting System Parameters

Importing an Assay File
1. Click on the Import selection button.
2. Select the filename to be imported by clicking on the
current file location.

button and navigate to the

3. Select the desired assay file (*.xml files only).
4. Click the Import button.



Note: Only files that have been generated using DS-Matrix software programs can
be imported into DS-Matrix software.
Browse for File

Import Selection

Import

Figure 4-17: Import/Export Screen (import options)
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Exporting a Data File
1. Click on the Export radio button.
2. Choose to export the data as either an XDB (Matrix) format or as a CSV comma
delimited spreadsheet type file. Click on the
button in the center of the right side of
the screen (not the browse button at the bottom), find the desired file location, and name
the export file, and click Save. DS-Matrix will assign the file extension.
a. If you export the file as an XDB file, the data file can only be opened in DS-Matrix.
3. Choose plate data by highlighting the desired plate identifier in the list.
4. Click Export.
5. If the data is imported into a spreadsheet, the well location data will be in the first column
and the OD data will be in the second column.

Importing a Data File
1. Click on the Import radio button.
2. Click on the



button and find the desired files.

Note: Plate Data files must have the *.XDB extension. Assay files must have the
*.XML extension

3. Click the Import button.



Note: Only Plate Data files that were created using DS-Matrix and saved as *XDB
files can only be imported. Data cannot be imported into DS-Matrix from other
software applications such as spreadsheet (*.CSV) files.

4. When plate data is imported into a database, the associated assay information will also
be imported into the database.
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4.7 Reset Auto Recovery
Auto Recovery is a mechanism that allows the DS2 Matrix software to automatically recover
from errors during a run without user intervention. When an error occurs, Matrix will display
a list of potential corrective actions, and the user is prompted to select the most appropriate
action in order to correct the problem (Figure 4-18).

Error
Recovery
Options

Figure 4-18: Error Recovery Screen

On the same screen (underneath the drop down list options), the user can check the Auto
Recovery checkbox to instruct Matrix to carry out the same action the next time the exact
same error is encountered. Matrix can then carry out some corrective actions without any user
interaction.

54

DS2® System Operator’s Manual

Chapter 4 Setting System Parameters

Figure 4-19: Reset Auto Recovery Screen

The Reset Auto Recovery function (Figure 4-19) erases the settings for the user-selected
corrective action for a particular error. The next time the error occurs, Matrix will prompt the
user to select a corrective action instead of carrying out corrective actions without user
intervention. To remove a specified auto recovery action from Matrix, check the checkbox
associated with the undesired recovery action and then click Delete. Auto recovery will no
longer be performed the next time the error is encountered.



Note: Use the Reset Auto Recovery function with great caution.
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4.8 Event Log
The Event Log lists every function the DS2 performs during an assay. To view the event log,
click Tools > View Event Log, and the Event Log will display a list of events which occurred
since the current software session began. A new Event Log is created each time the software
is started.
1. To view logs from previous software sessions performed on a prior date, click the View
History button.
2. Choose a date on the calendar, highlight the desired Event Log and click Open. Each
operation performed is recorded in the event log.
3. To search for a particular text string (such as “error”), enter the desired text into the text
box at the top of the screen. Click Find to locate the first instance of the text. Click Next
to find subsequent instances.
Enter search text

Figure 4-20: Example Event Log
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4.9 Levey-Jennings Criteria
Levy-Jennings charts monitor the performance of an assay over time. Levy-Jennings charts
include plots of the individual results versus assay data to analyze the dispersion of results
about the cumulative mean value. Typically, a specific well or sample type is used, such as a
control or other sample type, for which an expected value is available.
Levey-Jennings charts on the DS2 can be displayed by Matrix software for specified wells on
an assay plate using raw OD values or calculated results (concentrations or ratios). Westgard
Rules may also be applied.
Specifying Levey-Jennings Criteria
1. Select Tools > Levey-Jennings from the Matrix main menu toolbar.
2. The following options screen will be displayed.
Time
Range

Assay

Figure 4-21: Levey-Jennings Criteria Parameters Screen
3. Select the Assay for which the Levey-Jennings analysis is to be carried out by
highlighting the desired assay in the drop down list.
4. Select the Time Range over which the assay will be analyzed. Selecting All displays
data for every run of that assay stored in the plate database. If you do not want to view all
data, select a time frame of one week, one month or one year to analyze data generated
within that time period. The user may also choose a starting date and all data generated
from that point in time will be analyzed. Alternatively, a number of the most recent data
sets (1,2,3,4…) can be selected.
5. Click Apply.
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Plates

Well
Selection

Calculation
Method

Figure 4-22: Levey-Jennings Plate and Well Selection
6. Select the Plates to be analyzed. Uncheck the check box for a plate if the data for the
specified plate should not be analyzed. When selecting plates, make sure all plates were
tested with the current version of the assay. If plates are selected which were tested with
a prior assay version, the Levey-Jennings program will not be able to analyze the data. A
new assay version is created whenever an assay is saved.
7. Check the check box for the wells containing the control (or other sample type) to be
used in the Levy-Jennings plot. Click the Average Replicates box if desired.
8. The number of plates chosen will equal the number of points on the graph.
9. If Raw OD data is used to generate the graph, select the Plate Data radio button. To use
calculated data following a Curve Fit, Threshold, or Ratio Operation, select the Data
Reduction radio button.
10. If pass/fail criteria are to be used, select the appropriate Quality Control cutoffs.
11. Click Run to display the plotted results in the lower portion of the window.
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Figure 4-23: Levey-Jennings Results
12. Click on the Report button to bring up a printable version of the results, including the
graph with header information containing the assay name, quality control test results, etc.
13. To save the data, click on the Save button.
14. To retrieve saved data and regraph, click on the Load button. Data must be saved prior
to trying to load it, or a message will appear that no results are available.
15. Click the OK button to close the Levey-Jennings window.
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4.10 ESP Calibration
Electronic Signature Pipetting (ESP™) is a sophisticated technique used by the DS2 for
detection of gross pipetting errors often caused by the presence of particulate matter, clots,
foam, or bubbles in the sample.
Correct use of ESP requires calibration of acceptable sample transfers for a given fluid with a
given pipetting profile and volume. This data is collected and stored in a database and is used
by Matrix as a reference for good data to compare against subsequent dispenses. Insufficient
sample transfer can therefore be detected and reported to the operator during a run.
Performing ESP Calibration
1. Click on Tools > ESP Calibration from the main Matrix screen.
2. The following screen will be displayed (Figure 4-24).
3. Type in the Fluid Name (e.g.: water), Volume, and Aspirate and Dispense profiles. The
aspirate and dispense profiles should match the programmed aspirate and dispense
profile values for the fluid in the fluids database. The volume must match the volume
programmed to be pipetted during an assay.
4. Specify the number of transfers to calculate the calibration values. .
5. Select the source of the fluid being calibrated.
6. Select the destination of the fluid being calibrated.
7. Click Run
8. Follow the instructions in the load wizard to prepare the system and click Done. The DS2
will then perform the fluid transfer and display the results (Figure 4-25).
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Fluid Name

Volume

Number of
Transfers

Run Button

Figure 4-24: ESP Calibration Main Screen

DS2® System Operator’s Manual

61

Chapter 4 Setting System Parameters

Figure 4-25: ESP Calibration – Results
9. Click Accept to accept the calibration results and click Reject if the results are not
acceptable for that particular transfer. The profile should appear relatively smooth
without unexpected sharp peaks or dips.
10. Repeat steps 7 and 9 for all transfers (see the value in Number of Transfers). The load
wizard will only appear once.
11. The data displayed can be changed by changing the selections in the View area. The
user may select all to view data for all transfers, or the user may select the specific
transfer number. Checking the checkbox for Min will display the data compared to the
minimum value for the data set. Checking the check box for Max will display the data
compared to the maximum value for the data set. Checking the checkbox for Mean will
display the data compared to the mean of the data set. The user may choose to have all
three checkboxes selected at the same time as this may assist in determining if the
transfer is within acceptable ranges.
12. If the calibration results are acceptable, click Save.
13. If the calibration results are not acceptable, click Done. Select Yes in response to the
prompt to leave the ESP calibration window without saving data.
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4.11 Fluid Level Tracking



Note: Do not use Fluid Level tracking with default Dynex supplied bottles and
vials. Fluid Level tracking is only required when using user supplied bottles and
vials.

Fluid level tracking requires gravimetric calibration for each liquid in a specified bottle or
tube. During the calibration routine, the operator adds a set volume of liquid to the bottle or
tube to be calibrated
(e.g.:1000 µL to a test tube).
During the fluid level tracking procedure, the DS2 aspirates a set volume of liquid from the
bottle or tube (e.g. 100 µL) and dispenses the liquid into a waste container. The operator is
then prompted to reweigh the bottle or tube. This aspirate and weigh cycle is repeated several
times, and the resulting weights are entered on the calibration screen.
Performing Fluid Level Tracking Calibration
1. To start the fluid level tracking calibration, click Tools > Fluid Level Tracking. The DS2
will provide detailed instructions on the completion of the calibration routine in the
Message Center text box in the instruction screens (Figure 4-26)
2. Additional screens with instructions on collecting weight data before and after the DS2
aspirates liquid from the bottle will be displayed. Follow the instructions on the screens to
complete the calibration.
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Message
Center
(operator
prompts)

Select Bottle
Type

Click Accept

Bottle
Description

Figure 4-26: Fluid Tracking Calibration Start Screen

Fluid Level Tracking Calibration Steps
1. Select the bottle or tube type.



Note: The user defined bottle or tube must be entered in the Bottle Type database
in order for the bottle or tube to be selectable from the drop down list.

2. Click Accept.
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Operator Instructions

Figure 4-27: Fluid Tracking Calibration Data Entry Screen
3. Tare the empty bottle or tube to use for fluid tracking.



Note: An analytical balance that can weigh to the nearest 0.001 g is needed to
complete the calibration routine.

4. Click Accept
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Figure 4-28: Fluid Tracking First Fluid Weight Entry
5. Follow the instructions in the Message Center and enter the first bottle weight. Press
Accept.
6. Follow the Load wizard prompts to prepare the system for the fluid tracking calibration
procedure.
7. Click Done when the load wizard is complete.
8. Click Accept to confirm that the items specified in the message center have been loaded
on the instrument.
9. Close the system cover and click Accept to begin the calibration procedure.
10. The DS2 will pick up a tip, aspirate fluid from the source bottle, dispense the fluid into the
waste bottle, prompt the user to weigh the bottle for the second time, and to enter the
second weight.
11. The range of weights to be entered is displayed. A different amount of water will be used
for different bottle types.
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12. A total of ten calibration points are used. Decreasing bottle weights will be entered as
fluid is aspirated out of the source bottle.
13. At any time during the fluid level tracking procedure, click Cancel to cancel the calibration
program, or Restart to reset the program.

Number
Calibration Point

Enter Next
Decreasing
Weight

Figure 4-29: Fluid Tracking Calibration Point 5 Weight Entry
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Chapter 5 Programming a New Assay
5.1 Defining Assay Parameters
The first step in programming a new assay is to define the assay parameters. Select File >
Assay Editor from the main Matrix menu. All assays must include the three default icons
shown in the Assay Screen (Assay Title Page, Microplate Pipetting Template, and Report
Format Set-up) plus at least one operation, such as a read or dispense operation. All assays
open to the Assay Title Page (Figure 5-1).
Assay operation icons must be dragged from the Operations toolbar into the Programming
toolbar in their proper sequence.
Assay Title
Page

Microplate
Pipetting
Template

Operations
Toolbar

Programming
Toolbar
Report
Format
SetUp

Figure 5-1: Assay Title Page Screen



Note: At least one assay must be created before a worklist can be defined and
run.
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5.2 Creating an Assay
5.2.1 The Assay Title Page
1. Select File > Assay Editor from the menu bar

Figure 5-2: Assay Title Page
2. The assay opens with the Assay Title Page displayed. Enter the Assay Title and Author
in the text boxes. The assay title may be different from the filename under which the
assay is saved. If a password is entered, subsequent attempts to open the assay will
require the user to enter the password in order to edit the assay parameters. The assay
may be opened as “Read Only” to view the assay parameters without making changes.
3. Kit lot information can be requested at run time when the consumables are loaded.


If the user checks the check box for Request kit lot data at runtime, the user will
be prompted to enter lot and expiration information for all consumables and fluids
each time the assay is run. The user can choose not to enter lot information
when prompted.

4. Click Validate when finished.

5.2.2 The Microplate Pipetting Template
The Microplate Pipetting Template allows users to determine the plate position of well types
such as Standards, Controls, and Test Samples. Wells will always be used for the well type
with every run of the assay.
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Defining Wells (Figure 5-3)
1. Click on the Microplate Pipetting Template icon in the Programming toolbar.
2. Click on the Clear All button to clear the plate so wells can be defined.
3. Click on the radio button for the desired Well Type definition (NC, negative control; PC,
positive control; CO, cut-off control, etc.). To change a well type definition, refer to
Section 5.2.3 (Well Type Definitions).



Note: If a curve fit is used in the data reduction, the default Standard well type
must be used to define the assay standards on the template

4. Select the number of Replicates desired by clicking the up and down arrows.
5. Determine if the replicates are to be oriented By Row or By Column by selecting the
appropriate radio button in the Replicates area. When replicates are added by row, one
replicate will be placed (for example) in column 1 (A1) and one replicate will be placed in
column 2 (A2). Replicates which are added by column will be added to the template
serially (A1, B1).
6. The user can click on each well individually, or the user can click and drag the cursor
over the desired wells to define them as the selected well type.
7. Repeat steps 3 through 6 until the entire plate has the desired well definitions for
standards, controls, samples, etc.
8. To clear an individual well, click the Empty radio button, and then click on the desired
well location in the template. Click on the Clear All button to reset all well types.
9. Choose the microplate type which will be used for the assay from the Microplate dropdown list. Only microplate types which are defined in the Plates database will appear in
the drop-down list.
10. Click Validate when finished.
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Microplate Pipetting
Template

Well Type
Options

e

Replicates
Number

Changing a Well
Type Definition

Toggle
Blank

Select
Microplate
definition

Clear All
Well Types
Button

Figure 5-3: Microplate Pipetting Template with Wells Defined

5.2.3 Well Type Definitions
By default, all 96 well positions in the microplate template are defined as test wells
(T1, T2, etc.). When Well Types have been assigned, the well becomes color coded for the
well-type defined by the user, and will be labelled with a symbol for the well type followed by
a sample number. Wells that are dispensed as replicates will have the same sample number
(e.g. T1).
Labels for Control wells can be changed and custom color-coded by clicking on the “Change
Label” button, with the exception of Standard (S) and Control (C), which cannot be changed
by the user.
Any well on the template can be made a Blank well by clicking the Toggle Blank radio
button, then clicking on the desired well (s) on the template that will be used as blanks. If
more than one well is selected to be a toggled blank, the ODs will be averaged from the
specified wells and the average subtracted from all other wells on the plate.

72

DS2® System Operator’s Manual

Chapter 5 Programming a New Assay

5.2.4 Well Type Labels
Label

Definition

S

Standard

C

Control

T

Test Sample

NC

Negative Control

PC

Positive Control

CO

Cut-off Control

PR

Positive Reference

SC

Serum Control

AC

Antigen Control

N

Negative

Report Format Set-up
1. Click on the Report Format Set-up icon.
2. Click on the Report Layout tab.
3. By default all the information in the left column will be included in the final report. To
remove unwanted information from the report printout, highlight an item in the right
column and then click on the Remove button. The order in which information is displayed
on the report can be changed by highlighting the report topic in the right column and
clicking the Move Up and Move Down buttons. Clicking Add will add the highlighted item
in the left column to the bottom of the right column. Clicking Insert will insert the
highlighted item in the left column above the highlighted item in the right column. Add All
will add all items in the left column to the right column in the order it appears in the left
column. Information that already exists in the right column will be duplicated. Clear will
remove all items from the right column.
4. Click Validate when finished.
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Information that will
be included on the
Report

Function
Buttons

Figure 5-4: Report Layout Definition Screen

Report Format
1. Click on the Report Formats tab.
2. Select Format Type by selecting the appropriate radio button (raw data, ratio, threshold,
curve fit, or spreadsheet). Data will be reported according to one or more of these options
as programmed in the assay. The user must define a format type for each of the different
operation types that will appear in the assay report. If a format type is not selected for a
data reduction operation, even if the operation is selected to appear on the report, only
the operation heading will appear on the report, no data will appear.
3. Check the Create Matrix check box for results to be displayed in an 8 x 12 array format.
4. Check the Create Table check box for data to be displayed in a tabular format. Use the
check boxes in the Table Options area to indicate which data to include in the table. In
the Results Order area of Table Options, select the order of results. Each well type is
indentified in the column on the left. For data for a certain well type to appear on the
report, the well type must appear in the column on the right. Well types can be added to
or removed from the right column via the following method:
a. Highlight the desired well type, and then click on the Add
well type to the report.

button to add the

b. Highlight the desired well type from the list, and then click on the Remove
button to remove it from the report.
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c. Click on the Add All

button to move all well types into the list.

d. Click on the Remove All

button to remove all well types from the list.

e. Click the up or down arrow next to the right column to move highlighted well types
up or down in the list.
f.

Click Validate when finished.

5. In the Numeric Options area, check the check box to Average the replicates if needed.
Enter the desired number of decimal places the numeric data should be rounded to. In
the Mean area:
a. Select the radio button for Arithmetic mean to perform calculations using
addition (+), subtraction (-), multiplication (*), and division (/). The arithmetic mean
of replicate determinations will be reported.
b. Select the radio button for geometric mean to perform calculations using the
antilog of the mean of the logarithms of replicates. Reporting the geometric mean
is useful when there is imprecision built into the result data.

Numeric
Options

Matrix or
Table
Option

Table
Options

Result
Order
Selections

Figure 5-5: Report Format Definition Screen
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Header Footer
1. Click on the Header Footer tab.
2. Select the desired Header and Footer options to be put at the top and /or bottom of each
report page by checking the check boxes associated with each piece of information.
3. Click Validate when finished.

Footer
Options

Header
Options

Figure 5-6: Header / Footer Options Screen
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Output to File
1. Click on the Output to File tab.
2. If the data report is to be used with software such as external spreadsheets, check the
Enabled check box.
3. Information can be divided for export using a tab, comma, space or semi-colon separator
by choosing the radio button associated with the desired option in the Separator area.
4. Select the data to be exported by checking the check box associated with the desired
data in the Select Data to Export area.
5. Assign a file name and path where the output files will be exported by clicking on the
button in the Output File Name area. The selected data will automatically export
as a CSV (text type) file every time the assay is run.
6. Click Validate when finished.



Note: A printer driver must be installed for reports to be viewed using the Matrix
software.
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5.3 Programming Assay Operations
The following Operations can be programmed into an assay:
1. Dilution of controls, standards, and test samples
2. Dispensing of reagents
3. Pipetting standards, controls, and test samples based on the microplate pipetting
template
4. Well-fill verification (to verify pipetting volumes)
5. Plate incubation (from ambient to 500 C)
6. Plate shaking
7. Plate washing
8. Plate reading at a specified wavelength
9. Quality Control assay verification
10. Ratio, Threshold, Curve Fit, Spreadsheet, and Boolean (custom) data reduction

Adding, Deleting, and Changing the Order of Operations in an Assay
1. To add operations to an assay, click on the desired operation icon, hold down the mouse
button and drag and drop the operation icon to the desired location in the programming
toolbar.
2. Define the parameters of the operation by clicking on the icon in the programming toolbar
and setting the parameter values in the operation programming screen.
3. Delete operations from the assay by clicking on the operation icon in the programming
toolbar, holding down the mouse button, and dragging and dropping the icon into the
trash can icon in the upper right corner of the Assay Editor window. Click OK to confirm
the action. Click Cancel if the assay should remain unchanged.
4. The order of operations may be changed by dragging and dropping an icon before or
after another icon in the programming toolbar.
5. As the assay is created, text describing the actions taking place in each assay operation
appears on the right side of the screen. Text describing the operation icon which is
currently highlighted will have blue font. Text describing all other operations will have
black font.
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5.3.1 Programming Assay Operations
Drag & Drop icons from the Operation
Toolbar to the Programming Toolbar

Operation Toolbar

Delete Icon

Programming Toolbar

Text
Detailing
Assay
Creation

Figure 5-7: Assay Programming Screen
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5.3.2 Dispense

Operation

Defining Dispense Parameters
The dispense operation is used to pipette reagents (reagent blanks, conjugate, substrate, etc.)
to the microplate. A reagent tip is used for dispense operations. Fluids defined as standards,
controls and specimens cannot be transferred to the plate using a dispense operation.
Select All/
Clear All
Dispense Icon
Select
Wells

Select
Reagent

Enter
Volume

Well to well
Delay for reagent
dispensing
(optional)

Figure 5-8: Programming Dispense Operation
1. Select the wells the selected reagent will be dispensed to by clicking and dragging the
cursor over center of the wells, by clicking on each well individually, or by clicking the
Select All button.
2. Selected wells will have a yellow √ mark.
3. Use the Fluid drop-down list to select the reagent to be dispensed.
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4. If a new fluid must to be added to the Fluids Database, click on the Fluids button. Click
on the

button to add a new fluid to the database. (Figure 5-9)

Fluids
Button
Well
Dispense
Delay

Figure 5-9: Add Fluids Dialog Box
5. Enter the Volume of the reagent fluid to be dispensed.
6. (Optional) Specify a Well Dispense Delay . The delay can be specified from 0.1 to 10.0
seconds. The DS2 will pause in between each well for the specified period of time while
dispensing reagent to the plate. This feature can be used to synchronize dispense
timings for reagents to eliminate assay drift.
7. Click Validate.
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5.3.3 Pipetting
5.3.3.1

Operation

About Diluting Samples

The DS2 Automated ELISA Processing System can dilute samples, controls and standards.
Dilutions can be performed in a single stage in standard microplates or in two stages using
deep-well strips. The DS2 adds diluent to a plate or deep well before the sample is added.
Clicking once on a well or well type in the microplate pipetting template allows dilution in the
deep-well strips. The selected wells are outlined red. Clicking a second time on the template
allows dilution in the plate. The outlines around the selected wells will change from red to
green.
The dilution ratios allowed for various dilution options are described below:

Dilution Mode

Allowed Dilution Ratios

Microplate
Dilution

Ratios of sample to diluent range from 12.5:1 to
1:29 (e.g. 10 L sample combined with
290 L of diluent to yield a 1:29 dilution).

Deep-well Strip
Dilution

Ratios of sample to diluent range from 12.5:1 to
1:199 (e.g. 10 L sample combined with 1990
L of diluent to yield a 1:199 dilution).

Two Stage Deepwell Strip Dilution

Ratios of sample to diluent range from 156:1 to
1:39,601 (e.g. 10 L sample combined with
1990 L of diluent in a deep-well, from which 10
L is combined with
1990 L of diluent in a second deep-well to
yield a 1:39,601 dilution).
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Setting Dilution Parameters
1. Drag the pipetting operation icon into the programming toolbar.
Pipetting Operation Icon

Drag and Drop

Figure 5-10: Programming the Pipetting Operation
2. Click the well locations on the template which will contain a diluted sample, control or
standard.
a. If clicked once, a red circle will appear around the well, indicating that dilution will
take place in a deep well.
b. If clicked twice, then a green circle will appear around the well, indicating that
dilution will take place directly in the well on the plate.

Figure 5-11: Dilution in Deep-Wells
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3. Click on the Definition tab.
4. Choose the “neat” fluid to be used from the drop-down menu.



Note: When a Test Well type is selected, the neat fluid will automatically be
designated as “sample” and cannot be changed by the user.

5. Choose the Diluent to be used from the drop-down menu.
6. Select the dilution ratio or absolute volume.

Definition Tab

Figure 5-12: Programming Pipette / Dilution Operation
7. Enter the desired dilution formula for each well:
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Figure 5-13: Programming the Pipette Operation (Example of defining a specified volume)
Dilution Formula

Explanation

1 to ….

A ratio of one part concentrate to a specified number of parts
diluent, for a total of parts C + D.
EX: 1 to 10 parts is made up of 1 part concentrate plus 10 parts
diluent for a total of 11 parts.

1 in …….

A factor of one part concentrate in a total number of specified
parts. EX: 1 in 10 equals 1 part concentrate and 9 parts diluent
for a total of 10 parts.

Volume specified

The exact amount of volume of diluent will be pipetted into deepwell strip or plate. Enter a neat fluid volume and a diluent
volume. If using a deep well for dilution, specify the target
volume. The target volume is the volume of diluted specimen to
be transferred to the microplate from the deep well following the
dilution step.

9. To perform a two stage dilution in the deep well strip, check the “Two Stage Dilution”
checkbox. Enter in the dilution formula information on the initial dilution tab, then select
the secondary dilution tab and enter in the dilution formula information for the
secondary dilution tab.
10. When performing the assay, if the user should be able to change the dilution volumes at
runtime, enable the option to Allow sample dilutions to be changed at runtime.
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11. When diluting specimens in the deep wells, the user may elect to have the specimens
stay in the deep wells for a specified length of time prior to being transferred to the plate
by entering the desired time into the Let deep wells stand before pipetting field. Deep
wells may incubate for up to 60 minutes prior to transfer. Alternatively, the user may
elect to pipette diluted specimens immediately after dilution is completed by checking the
pipette immediately after dilution check box. If neither option is selected, the software
will perform all required dilutions prior to transferring diluted material to the plate.
12. Click on the Optimizations tab.

Optimization
tab

Figure 5-14: The Optimizations Tab
13. Select an option by checking the checkbox to the left of each option. When diluting in the
microplate, the bottom three options are unavailable.
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Option

Description

Use new tip for dispense of sample

A new sample tip will be used to pipette each well.

Multishot for dispense sample

The same sample tip will be used for replicates. If
fluid for more than one dispense can be aspirated
at one time, the required number of dispenses will
be aspirated at once and pipetted into the required
wells.

Share dilution wells for microplate
replicates (volume will be scaled)

Only one dilution will be made for an individual
sample. The dilution will be used for all replicates
in the assay.

Share dilution wells for microplate
replicates (volume will be scaled)

Only one dilution will be made for an individual
sample. The dilution will be used for replicates in
all assays on the current worklist that share a
common sample diluent.

Force level detect before transfer (uses
new tip)

If selected, a liquid level sense is performed on
each deep well prior to pipetting the sample to the
plate. Choosing this option will increase the
pipetting time from the deep well strip to the plate.

14. Click on the Pipette/Mixing tab (Figure 5-15).
a. Enter the desired speed profile (speed that pipetting takes place).
b. Enter the number of desired mix cycles (the number of times the dilution mixture
will be aspirated and dispensed to ensure thorough mixing before final pipetting).



Note: Mixing Cycles can only be set for deep well strips. Mixing functions are not
available for dilutions taking place in microplates.
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Figure 5-15: Pipetting/Mixing Tab
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5.3.3.2

Pipetting without Dilution

The Pipette operation pipettes a specified fluid into selected wells. To pipette a control,
standard, or specimen directly from the vial to the plate:
1. Click and drag the Pipette icon onto the assay programming bar.
2. Click on the desired (target) well.
3. Select the desired Neat fluid from the drop down list.
a. To add a new neat fluid, click the fluids button.
b. Define the Neat Volume by entering the volume (in µL) into the text box. The Neat
Volume is the volume of neat fluid which will be pipetted directly into the
microplate well.

Figure 5-16: Pipette Test Samples
c. Select Multishot Allowed or Use New Tip if either option is desirable. If Multishot is
selected, fluid will be aspirated in one tip to dispense all replicates of an individual
test sample or reagent (up to the volume capacity of the tip). If neither option is
selected, if replicates are present on the microplate pipetting template, the same
tip will be used to dispense all replicates, but multishot will not take place.
4. Select an ESP Plus profile (Electronic Signature tracking to ensure pipetting was done
properly) if desired. In order for an ESP Plus profile to be available in the drop-down list,
an ESP calibration must be performed for the sample type and the calibration values
must be saved (Tools>ESP Calibration).
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5. By clicking on the View / Edit Pipette Order button, the user can program which wells
will be pipetted to the plate first. For example, if the user intends to pipette a negative
control in the beginning of the plate (NC1), then samples, then a negative control at the
end of the plate (NC2), then the pipetting order must indicate this sequence. In addition,
if the pipetting order is changed from the default order indicated by the software, the user
must select Use new tip for dispense of sample when pipetting diluted controls or Use
new tip when pipetting directly from the vial to the plate to ensure the pipetting order is
followed.
6. Max post pipette time is the acceptable amount of time that a plate can sit prior to the
next scheduled event being performed once pipetting is completed. This feature is useful
when pipetting plates in parallel, so that one plate is not inactive for extended periods of
time while operations are being performed on the other plate.
7. Click Validate to save the information.

Fluid to
Pipette

Target
Well

ESP
Plus

Use new
tip

Multishot
allowed

Figure 5-17: Pipette Standards and Controls
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5.3.4 Verify

Operation

Well Fill Verification is used to track accurate pipetting of fluids into specified wells based on
their OD readings. The solution in the wells at the time of well fill verification must be a
colored solution.
Well Fill Verify
Icon

Filter
Selection

Selected
Wells

Figure 5-18: Well Fill Verification Operation

Setting Well Fill Verify Parameters
1. Click and drag the Well Fill Verify icon to the programming toolbar to add it to the assay
sequence.
2. Select the wells for the well fill verify operation by clicking on the desired wells. A yellow √
will appear in selected wells.
3. Select the test and reference Absorbance Wavelengths the plate will be read at.
Usually a single wavelength is suitable.
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4. Well fill verification can be accomplished in several different ways. The user can:
a. Select the Enabled check box for OD Test. The absorbance from each selected
well will be expected to fall within the specified OD range.
i. To test that each OD falls within a range, check the High OD check box,
enter the highest acceptable OD for each well and enter the lowest
acceptable OD for each well. The user may choose to enter a High OD
value only and leave the low OD value blank. It is also acceptable to
uncheck the check box for the High OD and enter only the lowest
acceptable OD for each well. Select Increment if the previous well fill
verification results should be subtracted from the active set before
performing the test.
b. Select the Enabled check box for Median Test. Set high and low margins as
percentages around the median. Matrix will calculate the mean OD from the group
of wells, and then calculate an acceptance range based on the entered
percentages.
5. Well fill verification parameters may be entered for more than one group of wells. To
create parameters for more than one group of wells, select a new group number from the
drop down list, select the wells to be included in the new group, and enter in the
verification parameters that apply to these wells.
6. If Blanking on A1 is enabled, the OD from well A1 will be subtracted from all the other
wells before the verification is performed.
7. The user may add a shake step before reading takes place to ensure that no air bubbles
interfere with the reported OD. The user can specify a shake time of up to 9 seconds.
8. If any of the wells fail the defined well fill verification criteria, the software will stop and an
alert message will display which requires user interaction to continue. Therefore it is very
important that the user return to the DS2 when a well fill verification is taking place to
ensure no user interaction is required to continue the timeline.
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5.3.5 Incubate/Shake

Operation

The Incubate/Shake operation specifies a temperature and duration for plate incubation during
an assay, and also allows for shaking. For ambient (up to 25 o C) incubations, the plate will
stay outside the incubation chamber. For higher temperatures the plate will move into the
Incubation chamber.
Incubation Icon

Figure 5-19: Incubate/Shake Operation Screen
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Incubate/Shake Settings
1. Drag and drop the Incubation Operation icon into the Programming toolbar.
2. Define the Duration by clicking on hours, minutes, or seconds, then clicking on the up
and down arrows. Incubation durations can last up to 23 hours, 59 minutes and 59
seconds.
3. Set the Shortest and Longest duration allowed for incubation. The incubation duration
may be modified from the specified duration to fall within the given shortest and longest
limits by Matrix in order to best-fit assay operations.
4. Set the Temperature. Matrix will monitor the temperature of the incubation chamber,
showing the current temperature in the upper right corner of the Timeline screen.
5. If the temperature selected is Ambient, the user may choose to time the incubation
starting with the first transfer of specimen to the plate by checking the Start from first
transfer to plate checkbox. This check box can only be selected when ambient
temperature incubation is chosen and when there are no operations inserted in the
program between the pipette operation and the incubation operation (for example, no
dispense may be present between the pipette operation and the incubation operation).
6. Select the radio button for the desired shaking option. The default for shaking while
incubating is off or Do not shake. The user may choose to:
a. Perform a short initial shake by selecting the Initial Shake radio button and
specifying a shaking time.
b. Shake the entire incubation time by selecting the Shake for entire duration radio
button.
7. Select the Speed at which the shaking will take place. Shaking is linear.
a. Low - shakes at 14hz with an amplitude of 1.5mm (~840 RPM)
b. Medium - shakes at 17hz with an amplitude of 1.5mm (~1020 RPM)
c. High - shakes at 20hz with an amplitude of 1.0mm (~1200 RPM)
8. Click Validate to save the settings.
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5.3.6 Wash

Operation

A Wash operation can consist of Purge, Dispense, Fill, Aspirate, Clean and Soak settings.
Summary of Wash Operations
Operation

Description

Purge

Dispenses fluid from the dispense wash pins while
the wash head is positioned over the purge tray. A
Purge is carried out at the beginning of a wash
protocol to fill the lines to the wash head with the
correct wash buffer and to remove any air bubbles in
the tubing lines. Dynex recommends not using less
than 3000 µL to perform a purge.

Clean

Dispenses fluid from the clean line from the dispense
wash pins while the wash head is positioned over the
purge tray. A Clean cycle is carried out at the end of
the wash protocol to prevent buffers from crystallizing
inside the tubing lines and causing blockages.
Dynex recommends programming a clean cycle as
part of every wash operation.

Dispense

Aspirates the contents of the well and then dispenses
a specified amount of fluid into the wells. If a bottom
wash is specified, the wash head is then lowered to
the bottom wash position. The fluid will be aspirated
from the bottom of the wells as wash fluid is being
dispensed.

Fill

Allows the user to fill the wells with a specific volume.

Aspirate

Removes the contents of a well by positioning the
wash pins at the aspiration height in the well and
aspirating the liquid from the wells.

Sweep

The aspiration pins move from side to side inside the
well during aspiration.

Super
Sweep

The aspiration pins move in a four-step X pattern
across the well during aspiration.

Soak

The contents of the wells sit for the specified number
of seconds after each dispense cycle. Once the soak
cycle is complete, the fluid is aspirated.
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Volume to Dispense
per cycle
Number of Cycles

Specify
Fluid

Purge
Volume
Clean
Volume

Figure5-20: Wash Operation Parameters Screen
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Setting Wash Parameters
1. Drag and drop the Wash Operation Icon into the programming toolbar.
2. Set the number of Wash Cycles to be performed, according to the assay protocol. The
number of cycles can be 1 – 9.
Note: The plate frame must contain whole strips for a wash operation to be
performed. Dummy wells may be used to fill in empty spaces to create a whole
strip.



3. Select to wash the plate Stripwise or Platewise.


If washing Stripwise, all cycles are completed on one strip before moving to the
next strip. For example: 3 cycles are programmed with a 5 second soak after
each aspirate-dispense cycle. The DS2 will aspirate and dispense the first strip,
wait 5 seconds, and then repeat this cycle 2 more times on the first strip prior to
performing any cycles on the second strip.



If washing Platewise, each cycle is completed on all strips on the plate before
another cycle begins. Using the same example scenario as the stripwise mode,
the washer will aspirate/dispense into the first strip, move to the second strip and
so on down the plate, soak the whole plate for 5 seconds, and then begin the
second cycle.

4. Constant Timing can be set if the time the wash operation lasts should be kept
consistent regardless of number of strips (samples) processed on a given day. Matrix will
add waiting time when washing partial plates in order to simulate the time to wash a
complete plate.
EX: 3 strips on the plate are being washed in strip mode. After finishing the third strip, the
washer will step through the remaining nine columns as if a whole plate were being
washed for three cycles per strip and the wash head will then be parked. If cycles are
performed in plate-wise mode, the washer will complete the first cycle and stay stationery
over the third strip for the time it would take to aspirate / dispense the remaining nine
strips. The washer then moves back to the first strip for the second cycle, and continues
in this manner for the rest of the number of cycles programmed.
5. Do Final Aspirate is used to empty wells before the next operation is performed. If Do
Final Aspirate is not checked, wash solution will remain in the wells following the wash
step.
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6. Select a Sweep Mode if extra aspiration is required to completely empty the wells of
droplets of wash buffer before the next operation is performed. Sweep mode options are:


None – normal aspiration will take place.



Sweep – Normal aspiration takes place, then the aspirate pins move once across
the well in a right to left motion to remove wash buffer which may be pooled at the
well edges.



Sweep on last cycle only – Sweep takes place only on the last programmed cycle.



Super sweep – Normal aspiration takes place, then the aspirate pins move across
the well in an x-patterned aspiration.



Super sweep on last cycle only – Super sweep takes place only on the last
programmed cycle.



Note: Select No Sweep and disable bottom washing whenever a C-bottom, Ubottom, or V-bottom plate is being used.



Note: Sweep should be used carefully to avoid scratching the bottom of the
microwells.

7. Set the Purge volume and select the desired wash buffer.


Purging fills the tubing lines with the specified wash buffer prior to beginning the
wash cycle.



Purging prevents the first few strips from getting air or bubbles dispensed into
them.

8. Set the Clean volume and select the desired clean fluid.
Note: A fluid must be added to the Washerfluid database with the load position
specified as the “clean line” in order for options to appear in the drop down list.




Cleaning uses fluid from the external bottle attached to the rear of the DS2 (bottle
C) to clean the tubing lines following the last wash cycle.



A cleaning routine should be performed before the DS2 is shut down, or
periodically during the day. Cleaning ensures that particulates in wash buffers do
not cause blockages in the wash head pins.

9. Set a soak time in seconds by entering the desired time into the Soak between cycles
for data entry field.
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10. The Synchronize Soak Delay from Transfer Timings check box can be enabled to
minimize OD drift across the plate due to differing incubation times between the strips.


The DS2 will synchronize column soak time based on the time taken to transfer
samples to the microplate. For example, if pipetting takes 15 minutes, and plate
washing takes 3 minutes, the first samples will be incubated for the correct
amount of time, while the later samples would incubate a shorter amount of time.
This timing problem can be resolved by synchronization.



There must be a Pipette step in the assay preceding the Wash operation in order
for the synchronization checkbox to be enabled.



There cannot be any operations in between the wash and the pipette operation in
order for the synchronization option to be available. The only exception to this rule
is the incubation operation. The incubation operation may be inserted into the
timeline in between the pipette and wash operation; however the Start from first
transfer to plate option must be enabled.



The synchronization check box is only enabled in strip-wise washing mode.

11. Enter the Dispense volume by using the up and down arrow keys. Dispense volumes
may be from 50 to1000 µL.


Choose the wash buffer from the washerfluid database drop-down list.



To add a wash buffer to the washerfluid database, click on the Fluids button.
Follow the prompts to name and define the fluid. The user may select either the A
or B bottle location, but it is recommended not to specify a location if multiple
wash solutions will be used on the instrument.

12. Use Bottom Wash if fast washing is required.


Bottom wash will squirt bursts of buffer into the well, while aspirating at the same
time. Bottom wash can save time and buffer if used instead of an extra wash
cycle. Bottom wash may be used with either plate or strip washing mode.



Specify the number of Cycles and the Volume of wash buffer to use by using the
up and down arrow buttons next to the associated parameter. 0 - 5 bottom wash
cycles may be programmed using 0-1000 µL.

13. Check the Fill check box to dispense fluid. The Dispense and Bottom Wash options must
be set to zero for the Fill option to become available. Fill may be used in either strip or
plate-wise mode.


The Fill operation may be used if a long soak time is needed. Program the Fill in
the Wash operation, then program an Incubation operation for the length of time
needed, then program another Wash operation into the assay.



Fill may also be used for well fill verification to test the washer dispense accuracy.

14. Check Aspirate if wells only need to be emptied of fluid and do not need washing. The
Aspirate checkbox does need not to be checked if wells are being washed normally.
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5.3.7 Read

Operation

The Read operation allows the user to choose the appropriate wavelength filters for use with
the assay and instructs the DS2 to read the absorbance of each well containing fluid.
Setting Read Parameters
1. Drag the Read Operation Icon

into the programming toolbar.

2. Select the Primary Test Filter and the Primary Reference Filter (if dual wavelength
mode is used). To change the default filter wavelength settings, use the Tools >
Absorbance Filter menu. To install new filters, refer to the Service and Maintenance
section of this manual.
Read Icon

Wavelength

Shake Time

Figure 5-21: Read Operation Parameters Screen

Wavelengths: Wavelengths for OD readings are determined by the specific filters installed in
the reader. The correct wavelength values must be entered for the installed filters in the
Absorbance Filters menu for valid results.
If using single-mode, a primary test filter wavelength must be entered. If using dual mode,
both filter wavelengths must be entered.
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5.3.8 Dual Wavelength Mode
The dual wavelength mode can be used if necessary to reduce errors caused by dirt and
scratches on the bottom of the wells as these artifacts tend to scatter radiation equally,
regardless of wavelength.
The choice of test and reference wavelengths for the dual wavelength mode depends on the
particular enzyme/substrate reaction being tested. However, the following rules should
usually be followed:
1. The test wavelength (t) should be at or near the maximum absorbance of the reaction
product.
2. The reference wavelength (r) should lie outside the absorbance band of the reaction, but
not far removed.

The Reader subtracts the absorbance at the reference wavelength (r) from the absorbance at
the test wavelength (t) to minimize the effect of background noise.

405 nm

t

r

690 nm

FILTER WAVELENGTH

Figure 5-22: Dual Wavelength Selection

Shake Time: The shake time (in seconds) is performed prior to reading the plate. Plate
shaking may be used to eliminate air bubbles from the sample and to give the sample an even
meniscus.
Blank Mode: Wells to be used as blanks are specified in the microplate pipetting template. If
no blank wells are specified, Matrix will use air as the reference level for 100% transmission.
If more than one well is selected to be a blank in the microplate pipetting template, the ODs of
the average of the blank wells will be subtracted from all other wells on the plate.
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5.3.9 Quality Control

Operation

Quality Control Operation equations are used to ensure that an assay has worked properly and
that the data generated can be accepted. The QC equations place criteria on the raw OD data,
or data generated by a curve fit, threshold, ratio or spreadsheet operation.
1. Well ODs are accepted or rejected using criteria specified in the kit product insert (such
as comparison against a control well or against a numerical value).
2. QC equations may be applied to any Well Type that has been defined in the template. If
the QC equation fails, the user may elect to suppress all data from being output to
subsequent operations.
3. Quality Control operations are context sensitive, as some QC equations may only be
applicable to the results of a Curve Fit operation or to the results of a Threshold
operation.

Quality
Control
Icon

Functions
List

Report
Options

Equation
Entry

Curve Fit Quality

Figure 5-23: Quality Control Operation Screen
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Setting Parameters for the Quality Control Operation

1. Drag the Quality Control Operation icon

into the programming toolbar.

2. There can be more than one Quality Control operation in an assay. A quality control
operation only applies to the data reduction operation immediately preceding the Quality
Control operation. Therefore, if the kit package insert specifies that some QC equations
are based on raw data results and some QC equations are based off of another type of
data reduction output (i.e. concentration); the assay would require two Quality Control
Operations.
3. Double click on the desired Function to add it to the equation. Functions are used to
generate the equations. Continue to add functions until the equation is defined.
a. Mathematical functions (such as +, -, =, >, <) may be typed into the equation box.
4. Type in a Fail Message if desired. This message will be displayed in the report when the
equation criteria have not passed.
5. Click on the Add button to add the equation to the list of quality control acceptance
criteria.
6. Click on the Clear button to reset the Equation and Fail boxes so additional equations
can be created.
7. To change an equation already added to the list, highlight the equation to be edited,
make the desired changes in the equation text box, and click Change.
8.

To remove an equation from the list, highlight the desired equation and click Remove.

9. The Quality Control equation checks will be performed in the order they appear in the list.
Therefore if one equation depends on another equation taking place first, the equation
which must be performed first must appear in the list before the dependent equation (for
example: the “i” function equation must appear closer to the top of the list than the “valid”
function equation). To change the order of the equations, highlight the desired equation
and click Move Up or Move Dn.
10. Options for QC Report handling include the default reporting of all QC results (Full QC
Report). If the QC fails, all other results can be suppressed by checking the Suppress
results if QC fails checkbox. This feature may be important if data is automatically
being exported from Matrix into other files. QC results can also be related to an individual
reagent lot by checking the Lot specific checking of control values checkbox (the
Request kit lot data at runtime checkbox must be enabled in the Assay Title Page
screen for the lot information to be available for reporting).
11. Select options for Pos/Neg, Curve Fit, and/or Auto Outlier Removal, if the options are
available. A Curve Fit or Threshold operation must to be included in the programming
toolbar before Quality Control Operation icon in order for these choices to be enabled.
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5.3.9.1

Quality Control Functions

See Appendix C for function descriptions and examples which can be entered into Quality
Control Equations.
5.3.9.2

Typical Quality Control Equations

Example: the template includes 4 NCs and 3 PCs
1. If any NC OD value is greater than 25% higher or lower than the mean OD value of all
the NC’s, it must be rejected, enter:
0.75*NC<=NCi<=1.25*NC
2. If the test must be rejected if one of the NC OD value fails the first Quality Control
equation, enter:
valid(NC)>=3
3. If the average OD value of the Negative Controls must be more than 0.5 OD, enter:
NC>0.5
4. If the average OD value of the Positive Controls must be greater than 20% of the average
OD value of the Negative Controls, then write:
PC>0.2*NC
5. If the average Negative Control OD value must be less than half of the average PC OD
values, enter:
NC<PC/2
6. If the CV% of the Negative Control must be less than 15%, enter:
CV(NC)*100<15
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5.3.10

Ratio

Operation

The Ratio equation is used to convert raw data using mathematical equations, which often
expresses sample results as a ratio of a control value. Ratio calculations are frequently used in
competitive inhibition assays or when detecting an increase in some factor over a normal
baseline value. Every value on the plate is fed into the equation and the resulting values are
reported and passed on to subsequent operations. Ratio operations can also be used to
multiply wells on the plate by a correction factor, or to perform any calculation which is
required for further data processing.
EX: In the equation “Sample/PC”, all sample OD values will be converted to a ratio of the
average OD value of the Positive Controls.
Results from the ratio equation may be flagged with a user defined “result” or “flag” by
clicking on the Results Flagging tab.
EX: In the equation “Sample>NC then SICK” data calculated from the “Sample/PC” equation
will be flagged based on whether the results are higher or lower than the calculated negative
control value.
Ratio Icon

Figure 5-24: Ratio Operation Screen
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1. Drag the Ratio Operation icon

into the programming toolbar.

2. To create a Ratio equation, double-click on the Functions which will make up the
working components of the equation.
3. Common arithmetic functions, such as addition (+), subtraction (-), multiplication (*), or
division (/), etc. may be typed into the equation box.
4. Enter the Units the data is to be reported in, such as “mg/dL”.
Condition Expression

Results Flagging Tab

Function List

Figure 5-25: Results Flagging for the Ratio Operation
5. Click on the Results Flagging tab in order to specify a phrase that either replaces a
numerical result or is displayed next to a result. The phrase will be initiated whenever the
numerical result meets the criteria programmed. Results Flagging is optional and should
not be used if an LIS is being used.
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The Condition is the Results Flagging expression, such as “Sample>NC”. If text
is to be reported instead of a numerical result, it can be typed into the Result box.
Use of a Flag indicates the entered text will be reported along with the numerical
result. Either a Result or a Flag can be entered, but not both.



Examples of Results Flagging:
o

The text “20 mg/dL” may be displayed instead of the actual numeric value
whenever a test result is less than 20 mg/dL if the text string is entered
into the Result field.

o

A flag of “Abnormal Low” might be displayed along side the numeric result
if the result is less than 20 mg/dL and the text string is entered into the
Flag field.
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5.3.10.1 Ratio Function Entries
See Appendix D for possible mathematic and function entries which can be used to write
Ratio equations.

Typical Ratio Equations
1. To convert all sample OD values to a ratio of the average OD of the Positive Control
replicates, enter the equation: Sample/PC.
2. To convert all values into larger numbers than the OD units, enter an equation such as:
sample/0.25.
3. Using an equation such as T1/PC (The result of Test well 1 divided by the positive
control) will cause DS-Matrix to replace all values on the plate with the result of this
calculation. In other words, if T1/PC=25, then every single well on the plate would have a
value of 25 on the report.
4. To multiply all values on the plate by a correction factor


Sample*VariableX (where X is replaced by an integer)

When these equations are entered, the user will be prompted at the beginning of the load
wizard to enter the value for the variable.



Note: Check the Ratio radio button when setting up the Report Format in an
assay to have ratio information included on the report in either a Matrix or Table
format.



Note: When creating ratio equations, use the Well Symbols from the Template to
create the equations.
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5.3.11

Threshold

Operation

The Threshold operation converts either raw OD data or calculated result data (i.e.
concentrations) into symbols or phrases denoting positive and/or negative results which fall
above or below a user defined threshold. In order to use this operation, Threshold limits must
be defined.
A negative limit is set using the “–” data label and a positive limit set using the “+” data label.
These positive and negative limits are required to use the limits function. Three additional
positive results levels (++, +++, and ++++) are also available, but not required.
Threshold limits may be entered directly into the equation textbox as absolute numbers. A
result that falls above or below the value entered will be recorded as positive (+) or negative
(-) instead of the actual value. The value entered for the threshold limit may be based off of
raw data, ratio, curve fit or spreadsheet output.
If the – value is lower than or equal to the + value then results below the –value are
negative and results above the + value are positive.
If the – value is higher than the + value, then results below the + value are positive and
results above the – value are negative.
Alternatively, conditions may be introduced into the limits equations. For example, test
sample result values may be compared to control result values or to the average of a number
of samples to determine if they are a positive or negative result.
DS-Matrix leaves a grey zone when there is a gap present between the values programmed for
the – and + equations.
The user can change threshold labels to any descriptive words or numbers. For example, the
default “-“ label may be changed to “Negative” by clicking on the text box and typing in the
desired text.
Equation

Functions

Well type limit
Value Limit

Figure 5-26: Threshold Operation Screen
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Entering Threshold Equations
1. Drag and drop the Threshold Operation icon

into the programming toolbar.

2. Enter absolute values (OD, concentration, etc.) for the positive and negative limit levels (if
values are output from another operation (such as a curve fit), that operation must appear
in the programming toolbar before the Threshold Operation).
3. Alternatively, the user may double-click on a function in the Functions list box to enter
this function. Arithmetic operators may be entered.
EX: PC*2 for limit level +++
4. In the Label column, change the default labels to words or other labels as desired.
5. When all equations and labels have been entered, click Validate.

The DS-Matrix program ensures each equation is valid and contains no errors. If any of the
equations are not valid, the DS-Matrix program will display an error message. If this occurs,
edit the equation as required for correctness.
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5.3.12

Curve Fit

Operation

In the Curve Fit operation, DS-Matrix software constructs a standard curve graph using OD
values from standards of known concentrations.
From the graph, the concentrations of test samples are determined by finding the
concentration that corresponds to a given OD reading. Concentration data is always plotted on
the X-axis, and OD data is always plotted on the Y-axis.
To use the Curve Fit operation, standards of increasing concentrations must be included in the
assay template.
Only one curve fit operation can be programmed into any given assay. To test data using more
than one curve fit, another assay must be created. When the Report is generated from the first
assay, data can be recalculated and another curve fit generated by clicking on the New Assay
button in the report viewer toolbar and generating a report using different a different assay.
Specify
Standard
Concentration

Standard
Concentrations

Figure 5-27: Curve Fit Concentration Entry
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Entering Standard Concentrations
1. The plate template is displayed in the Curve Fit Operation Standards tab screen.
2. To enter Standard Concentrations permanently into the assay, select the Now radio
button. If standard concentrations will be changed frequently, the user may select the At
run time button to enter standard concentration values at run time. To enter the standard
concentrations using the Now radio button, enter the concentration for Standard 1 (S1)
into the Concentration Entry box. Click on the Standard 1 well(s). A small box will
appear in the lower right of the well, showing what concentration was entered for that
standard.



Note: If entering standard concentrations at runtime, the results cannot be
generated using the “New Assay” feature in the report.

3. Enter the concentration value for the second standard in the Concentration Entry box.
Click on the wells for the Standard 2 to set the concentration for Standard 2 (S2).
Continue this process until all standards have an associated concentration.



Note: If performing a log/log curve fit, a standard with a concentration of zero
should not be defined in the curve fit operation.

4. To increment each standard concentration by a specific amount, click the Additive
Factor radio button and enter the number to be added.
EX: Standard 1 (S1) has a concentration of 1 and an Additive Factor of 2 is used. The
next standard (S2), upon clicking the well, will automatically be assigned a value of 3.
The next standard selected will be assigned a value of 5 and so on until all standards
have an assigned concentration.
5. A Multiplication Factor can be used to increment each successive standard by a
specified amount. Click on the Multiplication Factor radio button and enter the
multiplication factor. The first standard must be greater than 0 for this feature to work
properly.
EX: If the first standard (S1) has a concentration of 2, and the Multiplication Factor is 4,
then the next standard well selected (S2) will automatically be assigned a concentration
of 8.
6. Normalization can be enabled by checking the Normalization checkbox. If the dilution
value is changed at run time, checking the normalization will normalize the concentration
value to the original assay dilution value.
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7. A Variable Standard Multiplier can be used for standards entry. The Multiplier Factor
radio button must be selected and the Variable Standard Multiplier box must be
checked.
a. The first standard concentration must be greater than zero.
b. Click on the first set of standard wells (S1) to enter the first concentration. Enter
the multiplier for the next standard in the Multiplier box, then click on the second
set of Standard wells (S2). Enter a third multiplier for the third set of standard
wells. Click on the third set of standard wells (S3). Continue until all standards
have an assigned concentration.
EX: If the concentration of the first standard (S1) is 1, and the first multiplier is 2, then the
first standard (S1) will have a concentration of 1 and the second standard (S2) will have a
concentration of 2. If a multiplier of 4 is then entered the third standard (S3) will have a
concentration of 8.
8. Units can be entered as mg/mL, µg/mL, etc. by entering the desired units in the Units
box.

Axes
Selection

Figure 5-28: Curve Fit Type Selection Screen
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Fit Selection
1. Click on the Fit Type tab in the Curve Fit operation.
2. Highlight the type of regression DS-Matrix should use to generate the graph. See
Appendix C for equations defining curve fits.
Fit Type

Description

Linear

Linear polynomial regression

Quadratic

Quadratic polynomial regression

Cubic

Cubic polynomial regression

Quartic

Quartic polynomial regression

Polygon

Point to point straight line fit

Cubic Spline

Smooth curve cubic spline fit

Sigmoid

S-shaped curve fit with four definable
parameters

Log/Logit

S-shaped curve fit with definable parameters

Akima

Smooth curve which passes through all data
points

Calculation Options
1. Check the Average the standard replicates checkbox to have the mean of the standard
replicates used to generate the curve, rather than individual replicate points. Averaging
the replicates will make the graph easier to interpret.
2. Data can be extrapolated beyond the lower and higher ends of the graph if the
Extrapolate the data checkbox is checked. According to generally accepted analytical
chemistry practice, the standard values should always cover the entire range of expected
sample OD values. Extrapolation is generally not recommended but it may be approved
for data reduction according to reagent kit documentation. Extrapolation should not be
used with a sigmoidal fit.
Calculation Option

Description

Average the Standard
Replicates

Replicate values for standards are
averaged before they are used in curve
fitting.

Extrapolate the Data

The graph is extended beyond the plotted
data points by extending the curve.
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3. There are 4 axes options for data plotting. To select an Axis Scaling option, click on its
corresponding radio button.

Axes Selection
Axes Scaling

X-Axis

Y-Axis

Lin/Lin

Linear

Linear

Log/Log

Logarithmic

Logarithmic

Log/Lin

Logarithmic

Linear

Auto

Selected by Matrix

Selected by Matrix

4. Any scaling options that are not compatible with the chosen curve fit type will be disabled.
EX: If a Sigmoid fit type is highlighted, the axes selections will be disabled, but the
Sigmoid Parameters options will be active.
5. All four of the Sigmoid, S-shaped curve Sigmoid Parameters are user-definable. To
define a parameter, check the box for the desired parameter and type a number in the
textbox. If no options are selected, Matrix will set the A parameter to the lowest standard
concentration and the D parameter to the highest standard concentration. Matrix will then
define the other standard points to obtain an S-shaped curve.
6. The number entered for maximum Iterations is the maximum number of times Matrix
software will attempt to construct a satisfactory plot before aborting the operation. The
default value of 20 is suitable for most applications, however the minimum allowable
number of iterations is 1 and the maximum number of iterations is 29999.
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5.3.12.1 Graphing Options

Graph Title
Axis Labels

Figure 5-29: Options for Graph Scaling

Graphing Options
1. Click on the Graph tab in the Curve Fit operation. By default, a graph will always be
produced based on the regression chosen.
2. Enter a title for the graph (if desired) by entering the title in the Title textbox.
3. Titles can also be entered for the vertical and horizontal axes by entering the desired
titles in the Label: text boxes.
4. By default Matrix will use Auto Scaling to determine the best fit for the vertical and
horizontal axes based on the range of data.
5. If Manual scaling is chosen, the user can then define the minimum and maximum
numbers to be used to define the axis when the curve fit is displayed graphically. In the
Minimum box the lowest value for either the standard concentration or OD may be
entered. In the Maximum box a higher OD or standard concentration may be entered.
Tick Marks will divide the axis evenly between the min and max entered numbers,
incrementing by the value entered into the text box.
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Results Flagging
1. Click on the Results Flagging tab in the Curve Fit operation.
2. Results Flagging equations are used to specify criteria for generating a text flag when the
specified results are encountered.
The Condition is the Results Flagging equation.
The Result is the text to be reported instead of the numerical value.

Results Flagging Tab

Equation
Entry
Add, Move,
Delete Buttons

Figure 5-30: Results Flagging Tab
The Flag is the text to be reported along with a calculated numerical value.
3. An unlimited number of Results Flagging expressions can be defined for an assay.
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5.3.13

The Spreadsheet

Operation

The spreadsheet operation allows the user to create a table or matrix of data generated by
adding or subtracting well values from one another. The user can manually input the
calculation to be performed on a well by highlighting the well and entering an equation (For
example: B2-C2). Using Auto Difference Mode allows the user to select options which can
be applied to the whole spreadsheet. A custom functionality is also built into the spreadsheet
operation (Boolean Function Assay). This functionality should only be used by those
performing certain assays.
Spreadsheet
Operation
Equation Entry

Figure 5-31: Spreadsheet Operation Screen
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The Spreadsheet Operation
1. Click on the Spreadsheet Operation Icon and drag it into the programming toolbar.
2. Highlight a cell in the spreadsheet and enter a calculation or formula for that individual
well, for example A1 – H12. (This will take the incoming data reduction result from the
well at H12 and subtract it from the incoming data reduction result from the well at A1.)
The resulting value will be the output for that cell. This result will be passed to the next
data reduction step.
3. Use the buttons to facilitate spreadsheet equation entry:


Select the Cut button to remove a calculation from a cell, and then use the Paste
button to paste the calculation into the desired cell.



Select Copy to copy a formula, and Paste to move the formula from one cell to
another (the calculation cells will offset to reflect the selected cell).



Select Delete to remove a calculation from a cell and permanently remove the
calculation from the spreadsheet.



Clear All will remove calculations from all cells in the spreadsheet operation.

4. Alternatively, the user may select the Auto Difference Mode button and select a formula
to be applied across the entire spreadsheet. Auto Difference Mode offers the user preprogrammed automatic subtraction equations (see Table: Auto Difference Equations)
Auto Difference Equations

Equation

Rows A-B
Rows B-A
Rows B-C *
Rows C-B *
Columns 1-2
Columns 2-1
Columns 2-3 *
Columns 3-2 *
Halves 1-7
Halves 7-1
Halves 2-7 *
Halves 7-2 *
Halves A-E
Halves E-A
Halves B-E *
Halves E-B *

Calculation performed

A-B
B-A

C-D E-F
G-H
D-C F-E
H-G
B-C
D-E
F-G
C-B
E-D
G-F
1-2
3-4
5-6
7-8
9-10 11-12
2-1
4-3
6-5
8-7
10-9 12-11
2-3
4-5
6-7
8-9
10-11
3-2
5-4
7-6
9-8
11-10
A1-A7............H6-H12
A7-A1............H12-H6
B2-B7............G6-G11
B7-B2............G11-G6
A1-E1............D12-H12
E1-A1............H12-D12
B2-E2.............B11-E11
E2-B2.............E11-B11

* These options ignore Columns 1 and 12, Rows A and H.
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Figure 5-32: Selecting an Auto Difference Mode Equation

Figure 5-33: Auto Difference Mode Equation applied to spreadsheet (Row A-B)

Results Flagging
1. Click on the Results Flagging tab in the Spreadsheet operation.
2. Results Flagging equations are used to specify criteria for generating a text flag when the
specified results are encountered.
The Condition is the Results Flagging equation.
The Result is the text to be reported instead of the numerical value.
The Flag is the text to be reported along with a numerical value.
3. An unlimited number of Results Flagging expressions can be defined for an assay.
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Saving an Assay Program
1. When all of the operations in an assay have been programmed, click on File > Save As
from the main Matrix toolbar.
2. Type in an Assay Name (required) and Category (optional). Assays may be grouped
into categories for ease of retrieval.
3. Click OK.
Assay Name
(required)
Assay
Category
(optional)

Figure 5-34: Save Assay As Dialog Box

Modifying an Assay
1. Select File > Assay Editor from the main Matrix menu bar. Select File > Open from the
Assay Editor menu bar. The Open Assay dialog box is displayed (Figure 5-35).
2. Select the assay to be modified from the drop-down list, and then click OK.
3. Modify the assay operations and/or data reduction steps as desired.
4. After modifying assay settings, save the changes to the assay using File > Save.

Figure 5-35: Open Assay File Dialog Box
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Chapter 6 The Worklist
6.1 Creating a Worklist
A Worklist is created to define which assays will be run on which specific specimens. The
worklist specifies the samples that are to be run, their location in the sample rack, and the
assay(s) to be run on each sample.



Note: A worklist can be created only after at least one assay has been created.
The worklist can include assays run on one or two different microplates.
Up to 12 assays can be run on one plate if the assays have the same incubation,
reading, washing, and shaking specifications. All assays must also have the same
number of operations.
Only one worklist can be open at a time, although multiple worklists may be
entered on the Timeline.

To Create a New Worklist
1. Select File > Worklist Editor from the Matrix menu bar.
2. Select a new or saved Sample Batch from the drop-down list. A sample batch is defined
by its size (the number of samples entered, up to 100) and by the sample IDs assigned to
the physical location of the sample tubes. Once a Sample Batch has been defined, it is
saved, and can be edited up until the time that the worklist processing begins. The
Matrix software default name for a batch is Sample Batch followed by the next available
sequential number. This name can be changed by the user by entering the desired
sample batch name into the Sample Batch ID text box.
3. When creating a new worklist, select the number of samples by clicking on sample tube
icon associated with the last rack position containing a tube or by changing the number in
the Number of Samples text box. The rack locations containing tubes will turn green and
unused rack positions will remain gray.
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Assigning Sample IDs
1. Sample identification can be auto-assigned or barcoded. If sample ids are automatically
assigned, the name will default to be the sample batch id followed by a sequential
number. For example: if a sample batch named ”SAM” is being run, the sample IDs will
be auto-assigned as SAM-1, SAM-2, etc. If the sample batch is named “02262009” the
sample id’s will be auto-assigned as “02262010”, “02262011” unless a “-“ is included at
the end of the sample batch ID. Click Assign to assign the specimen IDs,
or
2. If the user wants the specimen ID to begin with text other than the sample batch id, then
the user should check the Use Pattern checkbox. Matrix will use the text entered in the
Use Pattern textbox for all sample IDs, followed by sequential sample numbering. For
Example: If the pattern ABC is entered, the sample ID’s will be ABC-1, ABC-2, ABC-3,
etc. Click Assign to assign the specimen IDs.
3. Click the

Next button.

Entering Sample IDs by Bar Code
1. Click the Scan Bar Codes radio button. The Verify Bar Codes checkbox is unchecked
by default. When the Verify Bar Codes checkbox is enabled, test sample tube barcode
labels will be read twice to ensure accurate scanning and positioning.
2. Click Next. The “Please Load Samples Now” dialog box displays. Load the sample racks,
and click OK when done. Samples may also be loaded prior to creating a worklist.



Note: All five sample racks must be in place prior to clicking the “OK” button. If all
sample racks are not in place, the barcode scanner will timeout and the barcodes
cannot be scanned.

3. The robotic arm will move to the scanner. Pull out each sample rack containing sample
tubes and push it back in so the scanner can read each bar code labels.



Note: The user is given 30 seconds to barcode scan each rack (30 seconds per
rack in use, using firmware version 1.08 or greater). Make sure to scan all racks
within the designated timeframe or the barcode scanner will timeout and the
barcodes cannot be scanned.

4. If a sample barcode is successfully scanned, the text box next to the sample tube icon
will be green and will populate with the barcode information. If the sample barcode is not
scanned successfully, the sample tube icon will turn red. The user may attempt to rescan
the rack until all barcodes have been successfully scanned, or information can be
manually entered for tubes with barcodes that are not capable of being scanned. Upon
successful entry of a manual sample ID, the sample tube icon will turn orange.
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5. Click the

button when done.

6. Select the assays that will be run and click Done (for more information see the “Choose
Assay” section of this manual).
7. If the Verify Bar Codes checkbox was enabled, the sample rack screen will prompt the
user to “Re-scan”. Rescan the sample rack. The software will ensure the barcodes
scanned match the first barcode entry. Any tube positions with mis-matched barcodes
will turn red.
8. Click the

button when done.

9. Sample ID’s will appear on the report when the assay specifies that data reduction
operation data should be displayed in a Table format (instead of a Matrix format) and the
Sample ID table option is checked.

Sample Batch
Name/Identifier
Enter number of
samples
Assign
Sample IDs

Figure 6-1: Worklist Sample ID Entry Screen
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Rack
Location

Figure 6-2: Worklist Select Assay Screen

Choose Assay
1. After the sample ID assignment is complete, click the Next button.
2. Choose the assay to be run, then either click on the Add Assay button or double click on
the assay name. An orange strip of check boxes will appear next to the sample ID’s.
3. To add additional assays, highlight the desired assay name and click on the Add Assay
button or double click on the assay name. An additional orange strip of check boxes will
appear on the screen.
a. The DS-Matrix software automatically assigns each assay to a different plate (as
indicated by the dark gray strip in between the assays). To combine an assay
with a previous assay on one plate, right click on the assay. A box stating
“Combine with Previous Assay” will appear on the screen. Click on this box.
The dark gray strip separating the assays will disappear, indicating the assays are
now being processed on the same plate. If the assays are not able to be
processed on the same plate due to conflicts in programming, an error message
will appear.
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Right click on this assay

Box displayed after right
clicking on the assay

Gray strip indicating
separate plates

Figure 6-3: Combining Assays on One Plate (before)

Figure 6-4: Combining Assays on One Plate (after)
4. By default Matrix assumes that all samples are going to be tested using the assays
chosen. By unchecking the checkbox next to an individual sample ID, the sample will not
be tested using that assay.
5. To save a worklist (optional), go to File > Save Worklist after selecting the assay(s) but
before clicking the Done button. Enter the worklist name, click “OK” and click Done.
a. To open saved worklist, choose File>Recent Worklists. Select a new sample
batch or select a saved sample batch. The worklist will open with the assays
already assigned.
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Using an External Worklist
1. To use an external worklist, select <external worklist> from the drop down list in the
sample batch dialog. Click OK.

2. Navigate to the external worklist file location. Highlight the desired file and click OK.
3. The software will open to the sample ID screen. If the tubes contain barcodes and the
user wishes to confirm the order of samples in the racks matches the worklist file, select
to verify barcodes. Click Next to begin assay processing. To overwrite the sample IDs in
the external worklist, enable the scan barcodes check box. All sample IDs contained in
the external worklist will be overwritten by the sample barcode scan.

Modifying the Dilution Ratio at Runtime
1. Open a worklist or create a new worklist by clicking on File > Worklist Editor from the
Matrix main menu. A worklist can also be opened by clicking on File > Recent Worklists
(only saved worklists will appear in this list).
2. The assay selected in the worklist must be programmed to perform a dilution step and
the box must be checked for Allow Sample Dilutions to be Changed at Run Time.
The Normalization check box should also be enabled in the curve fit operation to ensure
results are calculated correctly.
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Option to dilute samples at
runtime must be enabled
(checked)

Figure 6-5: Pipette Operation Screen
3. Click on the Dil (dilution button) shown in Figure 6-4.
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Edit Dilution
Button

Enter
Dilution
Change

Figure 6-6: Runtime Dilution Change Screen

Modifying the Dilution Ratios
1. The original dilution parameters will be shown in the left column of the Set Dilution
window.
2. Type in modified parameters for running assay in the right column of the Set Dilution
window. If changing a set volume dilution, only the volume of diluent can be changed at
runtime, not the volume of sample. Change the dilution for each individual test sample as
required.
3. Click OK. The sample dilution button (Dil) for the sample ID will turn green.
4. The Revert button erases any edits made and the test sample dilution will be performed
according to the original dilution parameters.
5. Once the assay is selected, dilutions will be modified (if required). When the Done button
is clicked, DS-Matrix will set up a schedule of assay events.
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Scheduling and Accepting a Worklist
1. Buttons which allow changes to the Timeline Schedule are presented at the top of the
Timeline. Active buttons will flash, while inactive buttons will remain grayed out.
Zoom

Pause
Abort

Play

Skip

Edit
Plate

Add
Assay

Start

Figure 6-7: Timeline Buttons

Button

Symbol

Action

Accept

A start button indicating that the
timeline is acceptable. Once
Accept is clicked the timeline
cannot be changed and will begin
processing.

Edit

Allows the sample batch and
assay to be changed on a
scheduled plate.

Add

Allows a second worklist to be
scheduled.

Fit Next

Allows the user to change the
scheduling of a second plate or
worklist added to the timeline.

Pause

Stops the Timeline at the current
operation until the Play button is
clicked.

Abort

Stops the Timeline at a convenient
stopping point and displays a Yes
/ No dialog box for aborting a plate
or the entire Worklist

Play

Resumes the Timeline from the
point the Pause button was
clicked.

Skip

Advances the Timeline by
skipping wait times in the
schedule. Not all wait times can
be skipped.
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Zoom IN

Opens up Timeline for closer view

Zoom Out

Backs out Timeline for broader
view

Position

Changes Timeline position and
zoom on the screen for the
optimal view.

2. Click the Accept button if no editing or assay additions are needed. The Timeline will go
from inactive to active status.



Note: All reagents and consumables must be ready to load on the DS2 when the
Accept button is clicked. Items such as tips and samples may be loaded before
clicking the Accept button. Waste may be emptied prior to clicking the Accept
button. All reagents (as much as possible) should be in the appropriate vial and
ready to load on the DS2 when prompted. If the load procedure is not performed
within the specified timeframe, timeline conflicts may occur.

3. The Load Samples wizard appears followed by the Load Consumables wizard when
the assay reaches the start line. The Wizard will request that the sample racks, plates,
controls, standards, diluents, reagents, and wash buffers are loaded. The system will
complete the wizard by prompting the user to empty the waste containers. The wizard will
indicate racks and positions into which fluids should be placed according to what is
programmed into each assay operation.
4. Clicking the Abort button allows the user to stop the entire worklist.
5. Once the consumables are loaded, the Skip button on the main menu bar may be clicked
to skip the wait time before the first assay operation.

Continuous Loading
To perform a run using continuous loading in DS-Matrix:
1. Select a Worklist Editor from the File menu
a. Enter Sample IDs manually or choose to barcode scan the sample IDs.
b. Add the desired assay(s) to the Worklist and click Done.
c. Accept the worklist.
d. Load the samples and consumables as requested by the Load Consumable
Wizard.
130

DS2® System Operator’s Manual

Chapter 6 The Worklist

e. Allow the Worklist to begin processing. Begin step 2 once the instrument has
reached an incubation period.
2. Open the Worklist Editor from the file menu. It is best to wait until the instrument is in
an incubation period before continuous loading.
a. If manually entering the sample IDs, continue with step c.
b. If barcode scanning the sample IDs, depending on the assay scheduling, the
operator may have to wait to scan the IDs until the system resources are
available for barcode scanning.
c. If there is a delay before scanning (see Figure 6-8), the operator must return to
the DS2 prior to the point barcode scanning is to occur.
Current time
Time operator must return

Start Line

Barcode Read Operation

Figure 6-8: Barcode Scanning Samples for Second Worklist in Continuous Load
d. The sample racks must be prepared and loaded on the instrument when
prompted. All sample racks must be in place for the barcode reader to be
activated. The system will time out if the first sample rack is not scanned within 30
seconds of the prompt (Note: if a firmware version prior to version 1.08 is installed
on the system, the system will timeout after 20 seconds). Any subsequent racks
are allotted 30 seconds each to be scanned.
e. Once the barcodes are scanned or IDs are manually entered successfully, add
the desired assay(s) to the worklist.
f.

Click Done.

g. The timeline will display with the second assay added to the worklist (see
Figure 6-9).
i.

Click Accept to accept the worklist or click Fit Next (if available) to see
other possible timelines. When the desired timeline is displayed for the
second assay Click Accept. Prior to clicking accept ensure that
someone will be available to load consumables when requested by
the DS2 (see Figure 6-9).
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Time to Return to Load Consumables

Load Consumables Step
Second Worklist Prior to Acceptance

Figure 6-9: Accepting the Second Worklist
3. Once the second worklist has been accepted, make a note of when the Load
Consumables step for the second worklist will begin. All reagents and consumables
must be ready to load on the DS2 PRIOR to this time. The Load Consumables step
allots roughly 3 minutes to load reagents and consumables for the second worklist. If this
3 minute period is exceeded, timing for both worklists may be affected (See Figure 6-10).
In a situation such as Figure 6-10., if loading consumables takes longer than the allotted
time, the wash step in the first worklist and the pipette step in the second worklist would
conflict, causing a timing change in the scheduled worklists.

Figure 6-10: Overlapping Worklists with Continuous Loading
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6.2 Monitoring Run Status
6.2.1 Timeline View
The Timeline View window displays the scheduled timing of all assay operations. The
Timeline View shows the user when events will occur (such as loading consumables), how
much time is remaining until worklist/assay completion, and the current assay step.
Current
Time

Accept Button

Start Line
Assay
Operations
Load
Consumables

Figure 6-11: Timeline View Window
Checking Consumables Status
1. For a report on the status of consumables, click on the
button at the bottom right
of the Timeline window. Consumables Status is available after creating the worklist, but
prior to accepting it. Consumables status allows the user the opportunity to prepare the
reagents required for the worklist prior to accepting the worklist.
a. Consumables that are tracked include all fluids (excluding samples), tips (sample
and reagent), plates, and washer fluids.
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2. The Consumables Status screen (Figure 6-12) will display the name of the reagent, the
reagent volumes, the number of tips left, and which assay is running.

Wells
Tested

Assay File Name

Washer Fluids Tab

Remaining
Tips

Figure 6-12: Consumables Status Screen

3. To show the status of a different neat fluid (reagent), click the
buttons beside the
fluid tube. To show the status of a wash buffer, click the Washer Fluids Tab.
4. The plate layout shows the wells being tested. At the top of the plate layout is the file
name of the assay being run.
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6.2.2 The Report
After a plate is finished testing, reports become available to view, save and print. The list of
recent reports can be seen on the main DS-Matrix screen.

Report Button

Plate ID

Figure 6-13: Retrieve Report

1. To see the Report immediately after a plate is finished, click on the
report for the last completed plate is displayed.

button. The

2. To review previous plate data, double click on the desired plate ID or highlight the desired
plate ID and click the report button.
3. To sort plate reports or to find the data for a plate tested on a specific date, click the View
All Reports button.
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Report
List by
Date

Figure 6-14: Sort Reports Screen
4. Uncheck the Show All box, and change the range of dates to search for the desired
reports. Click the Submit button.
5. Highlight the desired report in the list and click the Open button to display the Report.
Information included is displayed according to how the report was formatted when the
assay was created.
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Figure 6-15: Report Page One

Figure 6-16: Report Viewer Toolbar
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6. The Report Viewer Toolbar is at the top of the report screen. From this toolbar the
Report may be edited and printed. The report view, font type, and font size can be
changed. Most reports will be multiple pages. To scroll through the different pages and
review all results, use the Page Up and Page Down buttons.
7. Outliers can be removed by clicking the Outlier Removal button. This feature is
especially useful to redraw curve fits if one standard replicate or an entire point has an
OD that is too high or too low.


Highlight the well to be removed by clicking on it, and then check the checkbox
associated with the selected well. Click OK and the data will be recalculated.
More than one well can be removed at the same time.

Figure 6-17: Outlier Removal


When removing outliers, ensure that enough valid data points remain to redraw
the curve.

8. To reanalyze the data with a different curve fit, threshold levels, or ratio equation, click
the Recalculate Data button.
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Note: An assay with the desired operations must be created previously in the
Assay editor and saved in the assay database to reanalyze data using this feature.
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Figure 6-18: Selecting New Assay for Data Reduction


Select the desired assay with the new data reduction from the drop down list
(Figure 6-18).



Click OK. The data will be reanalyzed and displayed with the following
warning (Figure 6-19):

“WARNING! Results may have been reproduced using different settings to the
original assay.”
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Figure 6-19: Warning on Report
9. To save data which has been recalculated or had outliers removed, click the Save As
button. This option saves the report containing the new data reduction with a new name
(the name is user configurable). The saved report will be added to the list of reports in
the Matrix software for later viewing.
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Chapter 7 Starting the Run
7.1 General Considerations
7.1.1 Sample Types
1. Biological samples such as serum, plasma, urine, or spinal fluid are typically analyzed by
the system. Adequately prepared, stool and tissue homogenates can also be run on the
DS2.
2. Sample IDs may be manually entered by the operator or read from barcode labels on the
sample tubes.

Using Barcode Labels
1. When using an ink jet label maker, large dot spacing may increase the number of missed
scans. Test the labels before using them in an assay. Print quality is very important
to reliable scans.
2. Ensure the barcode density selected is between 0.005” and 0.013”.
3. The Vertical Scanner can read test tube barcodes up to 85 mm in length, including the 5
mm Quiet Zone on each side of the barcode. However, the readable barcode length may
vary, depending upon the code type and barcode density. The user should test barcodes
to ensure a specific barcode topology can be reliably scanned.
4. Check that the barcode Quiet Zone is sufficiently wide at both ends of the barcode label.
This distance must be at least 5 mm from the actual barcode to the end of the label. Be
sure that the Quiet Zone is not reduced; otherwise a missed scan could occur.
5. The test tube barcode that is to be scanned must be properly aligned. The barcode label
must be visible through the sample rack slot.
6. Check that the digits, letters, and other characters are correct for the barcode symbology
that is being used. Also, use the correct number of data digits for a specific barcode
symbology.
Supported Barcodes
Codabar

Code 128

Code 39

Standard 2 of 5

Code 93

Interleaved 2 of 5

MSI/Plessy

UPC / EAN / JAN

7. Symbologies with poor internal verification or partial decodes (such as Interleaved 2 of 5,
Standard 2 of 5, and MSI/Plessey) should be avoided if possible.
8. Be sure that the barcode scanner module window is clear, clean, and not scratched.
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7.2 Preparing the System
Filling the Wash Buffer Containers
1. Disconnect the wash buffer container and remove it from the system.
a. To remove the wash buffer container, disconnect the wash line by pressing on the
metal tab of the quick disconnect fitting and pull gently on the wash line.
Disconnect the liquid level sense connection by removing it from the connector
socket (Figure 7-1).

Quick Disconnect
Wash Buffer
Container

Liquid Level
Sense
Connection
Wash Buffer
container

Quick Disconnect
Waste Container

Wash Buffer
Container B

Figure 7-1: Wash Buffer Container B
2. Remove the top cap of the wash buffer container and fill it with the desired wash solution.
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Note: The wash buffer containers can hold up to two liters. DO NOT OVERFILL.
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3. Replace the wash buffer container in its storage location. Reconnect the liquid level
sense connection and the quick disconnect fitting.
4. Repeat Steps 1 through 3 for the second wash buffer container (if necessary).

Emptying the Waste Container
1. Two Quick Disconnect fittings connect the liquid and vacuum lines to the Liquid Waste
Container (Figure 7-1). Disconnect each one by pressing on the metal tab of the quick
disconnect fitting and gently pulling on the line.
2. Disconnect the level sensor Float Switch Connector (Figure 7-1) by pulling it out of the
connector socket.
3. Remove the waste container cap and discard the waste in accordance with local
regulations.



Note: Do not remove the Liquid Waste Container cap when the container is in the
DS2. Always remove the container first, stand it upright on the bench with the cap
pointed up, then remove the cap.

4. Rinse the waste container with DEIONIZED or distilled water. Discard the rinse water.



Note: The waste container can be disinfected with 70% ethanol, followed by
thorough rinsing with distilled or deionized water.

5. Replace and tighten the waste cap.



Note: Be sure that the waste cap is securely tightened. A vacuum leak will occur if
the cap is not properly tightened and will cause the software to report a vacuum
error condition.

6. Place the waste container on the system and reconnect the quick disconnect fittings and
the liquid level sensor.
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7.3 Starting the Run
Starting the Run
See Chapter 6 of this manual (the Worklist) for detailed instructions on creating a
worklist.
1. Display the worklist to be run by selecting File > Worklist Editor from the main Matrix
screen. A dialog box is displayed prompting selection of a batch or group of test samples
for the assays to be run.

Figure 7-2: Sample Batch Selection
2. Select a previously used sample batch, select to create a new sample batch (<new
sample batch>), or select to run an external worklist (<external worklist>). Click the OK
button. The Worklist Editor screen will be displayed.
3. When creating a new sample batch, select the samples that will be run by clicking on
individual tubes or by specifying the number of samples in the text box. By clicking the
last tube in a sample rack, the entire rack of tubes can be selected.
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Number of
Samples
Sample Batch
ID

Sample
Tubes

Next
Button

Figure 7-3: New Worklist Screen
4. Enter the Sample Batch ID or use the default name.
5. Create the sample IDs by selecting to have the DS-Matrix software auto-assign individual
sample IDs (using the sample batch ID or a pattern) or by selecting to bar code scan the
sample IDs.
6. Click the Cancel button to abort and restart the worklist. Click Next to accept the sample
IDs.
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Assay
Category

Rack
Indicator

Active
Assay

Omit
Sample
Checkbox

Figure 7-4: Assay Selection Screen

Saved
Assays

Done
Button

7. Select the assay category (if any) or All Assays in the drop-down list.
8. Select the assay(s) to be run by highlighting the desired assay and clicking the Add
Assay button or by double clicking on the desired assay. A pale orange strip will appear
next to the Sample IDs with the name of the assay at the top. If the check box next to a
sample ID is checked, then the sample will be run with the assay.



Note: The checkbox can be used to omit an individual sample from the run without
editing the sample batch list.

9. To remove an assay, click on the red X at the very top of the orange assay strip. To view
the previous screen, which will allow number of samples to be changed, click Previous.



Note: When more specimens are added by returning to a previous screen, new
sample IDs created must be selected to be run on any previously assigned
assays. The checkboxes for any added sample IDs will not be automatically
selected with previously added assays.

10. To abort the worklist, click Cancel, which will bring up a box verifying the worklist is to be
aborted.
11. Click Done when assay selection is completed. The Timeline screen will be displayed.
146
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The Timeline and Load Wizard
1. The Timeline screen with the assay steps scheduled is displayed (but transparent) once
an assay has been assigned to the worklist.
2. The operator must click Accept to start the run.



Note: Prior to accepting the timeline, the user should have all reagents, samples,
and consumables lined up and ready to load on the instrument. Items such as tips
or sample tube racks should be loaded prior to clicking accept. Failure to load
reagents promptly can lead to timeline conflicts.

Click the
Accept Button
to Start the
Run

Assay Steps
Transparent

Status Button

Figure 7-5: Timeline Screen
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1. After the timeline has been accepted, the software will prompt the user to load sample
tube racks and consumables. (Sample tube racks may be loaded prior to clicking the
Accept button.)
2. The Load Tube Rack screen will display the number of samples in the Worklist, along
with a diagram of the DS2 with tube racks highlighted. This prompts the operator to load
the appropriate sample racks. Sample IDs should not be edited, entered, or changed
during the load wizard. This screen is for loading the samples on the instrument only.

Figure 7-6: Load Tube Rack Screen
3. Load the sample racks and click the Green Check button.

Loading Consumables
1. After loading the samples, the load consumables wizard begins. The first screen of the
load wizard is a table which lists the reagents, standards and controls required for the
run. The software will prompt the operator to load them in the appropriate position with
the appropriate volume. Where possible, reagents should be in the appropriate bottles
prior to clicking the Accept button.
2. After an item is loaded in the designated position with the designated volume and any
required information is entered, click the
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button to display the next prompt.
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Click here
when finished
loading the
designated
consumable
Standard/

Control Tube
Rack
Click to
Cancel

Figure 7-7: Load Consumables Screen
3. Click the

button to abort the run.

4. The next screen prompts the operator to load plates and enter plate identifiers. The user
must enter a unique plate identifier. The plate identifier will assist the user to identify
which report they wish to view upon assay completion. Do not use slashes, periods or
other punctuation in the plate ID. The software also prompts the operator to load
sample tips, reagent tips and deep well strips, to check the status of the clean line, to
load the wash buffer into the wash container and check the status of the waste
containers.
5. After all consumables have been loaded, the run starts.
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7.3.1 Timeline View – Run Status
The Timeline View screen displays the scheduled timing of individual assay functions. These
time estimates are continuously updated as more runtime information is available to the DS2.

Assay Steps and
Time Estimates

Figure 7-8: Timeline View Screen

Using the Timeline View
1. To expand the Timeline View, click on the
2. To condense the Timeline View, click on the

icon.
icon.

3. To view the entire Timeline (as displayed above), click on the
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icon.
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Checking Consumables Status
1. For a report on the status of consumables during a run, click on the

Status button.

2. The Consumables Status screen will display with the tube types, fluid volumes, sample
and reagent tips, and plate maps that are being used in the worklist. During the run, the
consumables status is updated as fluids and tips are used.
Tube Types

Plate Map

Neat Fluids
Tab

Figure 7-9: Consumables Status Screen
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Generating a Run Report
1. To view a report on a completed plate, select the desired plate identifier from the recent
tests list and click on the

Report button.

2. The report can be viewed and printed from the View Report screen by clicking the Print
button.



Note: A printer driver must be installed for Reports to be viewed and printed using
the Matrix software.

Figure 7-10: View Report Screen
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Chapter 8 Routine Service, Maintenance and
Troubleshooting
8.1 Routine Maintenance Procedures



Note: Performing maintenance to the DS2 may expose the operator to hazardous
moving parts. Contact DYNEX for proper safety precautions to avoid possible
injury.



Note: The DS2 and DS-Matrix software must be shutdown once every twenty-four
hours to ensure proper DS2 performance.

The following periodic maintenance procedures are required for the DS2 Automated ELISA
Processing System:
Daily Maintenance
1. Empty and clean the tip waste container.
Warning: While the DS2 alone does not present a biohazard, the samples that
are used and all parts and consumables in contact with the samples must be
considered biohazards. Always wear protective gloves when handling
potentially infectious substances.
2. Empty and clean the liquid waste container as needed.



Note: If desired, the waste tip container and the liquid waste container can be
disinfected with 70% ethanol. The containers must be thoroughly rinsed with
deionized water before replacing, as residual alcohol fumes may affect the results
of ELISA assays.

3. Clean all external surfaces using a towel moistened with 70% alcohol. Pay special
attention to the pipette spigot, the tip sensor area, the wash head sensor, and the
wash head assembly. Remove any residual alcohol with a cloth dampened with distilled
water.
4. Clean the pipette spigot using a non-fibrous towel moistened with 70% alcohol. Remove
residual alcohol with a cloth dampened with distilled water.
5. Ensure all assays have a Clean step built into the wash cycle to prevent salt build-up in
the wash head.
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Weekly Maintenance
1. Empty the wash buffer containers and rinse them several times with deionized water.

Monthly Maintenance
1. Perform an alcohol/disinfectant wash.
a. Fill the wash buffer bottles with 70% alcohol or disinfectant.
b. Run a wash assay using fluid from wash buffer bottle A.
c. Run a wash assay using fluid from wash buffer bottle B.
d. Rinse the wash buffer bottles thoroughly with distilled water.
e. Fill the wash buffer bottles with distilled water.
f.

Run several wash assays using fluid from wash buffer bottle A until
alcohol/disinfectant is removed from the tubing lines.

g. Run several wash assays using fluid from wash buffer bottle B until
alcohol/disinfectant is removed from the tubing lines.

6 Month Maintenance
1. Check for gas spring robustness.
a. Close the DS2 cover.
b. Lift the DS2 cover approximately 8 inches.
i.

If the cover stays open or closes slowly, the gas spring is acceptable.

ii. If the cover falls down rapidly, the gas spring must be replaced.
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Annual Maintenance
DS2 Preventative Maintenance: One annual visit includes the following:


System Self-Test; check that all tests pass



Clean all exterior surfaces



Replace tubing set including filter and verify bottles



Replace lamp (once per year)



Replace reader fan filter and clean optics



Inspect bottle fitting O-rings and spigot



Run washer verification



Absorbance Reader (AM Module) verification using verification tools



Perform Pipette Check



Note: The dispense tubing and aspiration tubing may need to be replaced more
frequently than every year, depending upon the frequency of use and the severity
of operating conditions.
Contact DYNEX TECHNOLOGIES for information on replacement tubing.
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8.2 Cleaning and Decontamination
The DS2 Automated ELISA Processing System is constructed from materials that resist
chemical attack.
Spills should be cleaned as soon as possible. If you need to decontaminate the DS2 Automated
ELISA System (for example: before servicing the instrument or following a spill), clean the
system and then decontaminate it as described below.

Caution: Always disconnect the power cable before cleaning.

To Clean the System
1. Clean external surfaces, waste containers, wash containers and tubing lines with a cloth
moistened with mild laboratory detergent.



Note: If needed, dilute the laboratory detergent according to the manufacturer’s
instructions before using.



Note: If there is any doubt about the compatibility of cleaning agents with parts of
the DS2, contact DYNEX Technologies.

To Decontaminate the System
1. Wipe the surfaces with a cloth moistened with a 70% (v/v) solution of alcohol.
2. Clean the waste containers, wash containers and tubing lines with 70% alcohol. Run
70% alcohol through the tubing lines. Run deionized water through the tubing lines to
remove the alcohol.



Note: Remove residual alcohol from surfaces with a cloth moistened with
deionized water. Residual alcohol may affect the results of ELISA assays.



Note: If there is any doubt about the compatibility of decontamination agents with
parts of the DS2, contact DYNEX Technologies.
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8.3 Replacing an Absorbance Module Filter
Caution: The optics assembly may be hot. Allow at least five minutes for the
DS2 to cool after turning off the system before opening the optics assembly.

Caution: Be careful when removing the filter access panel, as there is a
possibility that the bulb may have broken.

To Remove a Filter
1. Remove the filter access panel from the rear of the DS2 by unscrewing the two screws
(one at the top and one at the bottom of the filter access panel). The filters are mounted
on the filter wheel as shown in Figure 8-2.

Filter
Access
Panel

Figure 8-1: Filter Access Panel of DS2
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2. Locate the filter that is to be removed.



Note: The absorbance filter 405 must stay in slot one on the filter wheel or the
DS2 will fail the self-test on start-up.

3. Firmly grasp the exterior filter housing with a pair of needle nose pliers.
4. Pull the filter out of the spring-loaded slot.
5. Replace the filter access panel.
6. Go to the Matrix main menu toolbar and select the Tools menu. Select Absorbance
Filter and change the wavelength in the position the filter was removed from to 0.
7. Click OK to save the changes.
Needle Nose

Pliers

Screws

Grasp Filter

Filter Wheel

Figure 8-2: Removing a Filter

To Install a Filter
1. Remove the filter access panel from the rear of the DS2 by unscrewing the two screws
(one at the top and one at the bottom of the panel). The filters are mounted on the filter
wheel.
2. Locate the filter position in which the filter will be installed.



Note: If a new filter is installed in a previously empty position or if the filter is
replacing a filter of a different wavelength, the wavelength of the new filter must be
entered in the main menu: Tools > Absorbance Filter.



Note: The 405 nm filter must be installed in Filter Position 1.
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3. Firmly grasp the exterior filter housing with a pair of needle nose pliers.
4. Push the filter into the spring-loaded slot.



Note: The bottom groove of the filter must be firmly seated in the filter wheel. If the
groove is aligned with the springs on the filter wheel then the filter has been
installed incorrectly and will cause invalid instrument performance.

5. Replace the filter access panel.
6. Go to the Tools > Absorbance Filter menu and type in the wavelength of the installed
filter in the corresponding position data entry field.
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8.4 Replacing the Tubing
To Replace the Tubing
1. Open the door at the front of the DS2.



Note: The door is hinged at the bottom. When opening, prevent the door from
dropping all the way forward.

Wash Buffer
Bottle A
Wash Buffer
Bottle B

Tip Waste

Waste Container

Door

Figure 8-3: Door and Wash Buffer Containers/Waste Containers
2. Disconnect the two Wash Buffer Containers and the Waste Containers. Remove the
Wash Buffer containers, the Waste Container and the Tip Waste Container.
3. The Pump/Valve Assembly that controls the washer dispense and aspiration functions is
behind the Tip Waste Container.
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Pump/Valve
Assembly

Figure 8-4: Pump / Valve Assembly
4. Disconnect the Wash Head Tubing from the Wash Head Manifold, and unscrew the
Manifold Thumb Nut as shown below. The black thumb nut is on the underside of the
DS2 platform.

Wash Head
Aspirate Tube

Wash Head
Manifold
Wash Head
Dispense Tube

Thumb Nut

Figure 8-5: Tubing Schematic
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5. Disconnect the Aspirate and Dispense tubes from the Wash Head Manifold.
6. Remove the Dispense Tube from the Pinch Valve and disconnect it from the Pump
Outlet.
7. Disconnect the other end of the Aspirate tube from the Waste Fitting.
Vacuum
Switch
Waste
Fitting
Wash Head
Manifold
Aspirate Tube
Vacuum
Line
Dispense Tube
Pinch Valve
Pump Outlet

Figure 8-6: Tubing Schematic
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8. Disconnect tubing from fittings for Wash Buffer containers A and B.
9. Gently pull the 90° fitting out of the Grommet and disconnect the Bottle C tubing.
10. Remove the tubes from the pinch valves and then disconnect them from the pump inlet.

Bottle A and B
Tube Fittings

Bottle A Tube

Bottle B Tube

90° Fitting
Grommet
Bottle C Tubing

Pinch Valves

Figure 8-7: Tubing Schematic
11. Insert the replacement tubing for the Pump Valve Assembly in the reverse order of
removing the tubing (steps 10 – 14).
12. Lift the Wash Head off its cradle and replace the twin bore tube.
13. Connect the free end of the tube to the Wash Head Manifold. Ensure the Wash Head is
oriented as shown below.
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Wash Head
Twin Bore Tube
Cradle

Figure 8-8: Wash Head Fitting
14. Flip the Wash Head over.

Figure 8-9: Wash Head Fitting
15. Rotate the Wash Head 90 degrees clockwise before locating it onto back onto the cradle.
Ensure that the Twin Bore tube is not kinked or twisted in a way that will prevent the flow
of fluid to the wash head.
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Figure 8-10: Wash Head Fitting
16. Remove and replace the tubing on the two Wash Buffer containers and the Waste
container.

Wash Buffer
Container Tubes

Waste Container
Tubes

Figure 8-11: Container Tubing
17. Connect the two Wash Buffer Containers and the Waste Container to the DS2. Place the
Tip Waste Container in its proper location.
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8.5 Cleaning the Wash Head Assembly
Caution: Always disconnect the power before servicing.

To Remove the Wash Head Assembly
1. Grasp the wash head assembly and lift it up from the cradle.
2. Move the wash head assembly and tubing clear of the DS2. If necessary, remove the
wash tubing and waste tubing.

To Clean the Wash Head Assembly
1. Pass the Cleaning Wire through the inside of each aspirate pin and dispense pin on the
wash head.
Note: There are two sizes of Cleaning Wires. One is for the aspirate pin, and the
other is for the dispense pin.



2. If necessary, the wash head may be soaked in disinfectant solution or 70% alcohol.
a. Remove the set screws on the sides of the wash head.
b. Ensure the wash head is standing up right in a container and fill the disinfectant
solution up to the gap on the wash head where the springs are located.
c. Soak the wash head for the desired length of time.
d. Replace the screws, being careful not to over-tighten the screws as overtightening may crack the wash head.
e. Reconnect the Twin Bore Tubing, ensuring the tubing is not kinked.
f.



Rinse the wash head thoroughly with deionized water to remove all traces of
disinfectant solution. Program the DS2 to perform a wash with water to ensure
proper cleaning.
Note: Dynex recommends performing a clean operation with deionized water at
the end of every wash operation.

To Replace the Wash Head Assembly
1. Position the wash head assembly back in the cradle.
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8.6 Dynex Technologies DS2 Troubleshooting Guide
Symptom
Sample Tip Errors

Possible Causes

Tips are being picked up,
but the system is not
detecting that a tip was
picked up

Tip sensor is dirty

System is not picking up
tips or is dropping tips in
transit

Tip pick up location is out
of calibration

Wash Head Assembly
Errors
The wash head is not being
picked up and/or released
successfully.

The wash head is being
picked up, but the system
does not detect that the
wash head was picked up.

Not using Dynex Tips

The pick up location is out
of calibration
The support posts on the
wash head park are not
aligned properly
Brass clamp may have
excess glue.
Wash head magnet and/or
sensor is dirty

Wash head sensor is out of
calibration
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Resolution

Clean the tip sensor area
(where the red laser is)
thoroughly with an alcohol
wipe.
Ensure in the future that
Dynex brand tips are being
used.
Calibrate arm, ensuring that
the tip used to calibrate the
system is put on the
instrument as securely as
possible.
Calibrate the arm at the
wash head pick-up position.
If instrument serial number
is below 1DSA-0339, see
TB149.
Check the brass clamp for
excess glue. Request a
replacement wash head if
there is glue.
Clean the wash head sensor
area (black dot in the metal
ring on the pipette) and the
magnet on the right side of
the wash head with an
alcohol wipe.
Perform an arm calibration
with the wash head detect
routine.
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Symptom
Possible Causes
Plate Washing Errors
Fluid is left in the plate after The wash head and/or
washing and aspiration.
aspiration pins are clogged

The dispense tubing is not
in place

The plate definition is
incorrect

The sweep mode selected
may be insufficient.

The system is out of
calibration
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Resolution
Clean the aspiration pins
using the cleaning wire. If
this does not work, remove
the 4 set screws from the
sides of the wash head
manifold and soak the wash
head standing upright in
70% alcohol with liquid
filled up to the spring gap in
the wash head. Rinse the
wash head and run test
washes to ensure the
problem is resolved.
Remove the tip waste
bucket. The dispense
tubing is the thin tubing
furthest to the left. Remove
the tubing from the pinch
valve, roll it and place it
back inside the pinch valve.
Open the plate definition for
the plate in use. Use the
“show” buttons to test that
all the plate parameters are
programmed correctly,
paying particular attention
to the aspirate height, the
sweep height and the sweep
stroke.
If no sweep mode is
selected in the wash step,
try a sweep or super sweep
mode for improved
aspiration.
Calibrate the wash positions
in the upper and lower plate
carrier. Ensure that the
aspiration pins are barely
touching the bottom of the
plate wells, that the pins are
centered in the wells, and
that the spring gap is not
compressed.
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Symptom
Plate Washing Errors
System is not dispensing
any fluid during purge and
wash

Possible Causes
System tubing is sealed in
the pinch valve
Wash buffer bottle quick
release valves are not
snapped in place

System is not dispensing
wash fluid/dispensing
sufficient wash fluid to row
“x”

Wash buffer is not
dispensed to the first few
columns during the first
wash of the plate

Pump is not primed or is not
functioning properly
The dispense pin
corresponding to row “x” is
clogged
There is a clog in the wash
head manifold

The wash head has not been
purged or has not been
purged sufficiently.
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Resolution
Remove the tubing from all
pinch valves. Roll the
tubing and insert it back into
the pinch valve.
Remove the quick release
fitting from the quick
release valve. Reinsert the
fitting into the valve,
ensuring a clicking noise is
heard to indicate the fitting
is securely connected.
Requires a service call.
Use the cleaning wire to
clean all dispense pins.
Remove the four set screws
in the wash head manifold
and soak the wash head
standing straight up in 70%
alcohol. Ensure the fluid is
only filled to the spring gap.
Rinse the wash head
thoroughly with water.
Ensure all wash steps have a
purge programmed. Ensure
the purge volume is at least
3000ul.
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Symptom
Plate Washing Errors
Wash fluid is overflowing
from the plate

Possible Causes
The dispense pins are
clogged
The aspirate pins are
clogged
The wash head manifold is
clogged

The dispense tubing is not
in place or is sealed
The plate definition is
incorrect
Pipetting and Liquid Level
Detection Errors
System is blowing bubbles
in the sample prior and may
or may not receive a clot
detection error

The tube in the system
configuration does not
match the sample tube in
use
The sample tube positions
are not in calibration

System is not pipetting
controls correctly

There are bubbles in the
control tube

System control tube
locations are out of
calibration
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Resolution
Clean the dispense pins with
a cleaning wire.
Clean the aspirate pins with
a cleaning wire.
Remove the 4 set screws
from the wash head
manifold. Stand the wash
assembly straight up and
soak it in 70% alcohol or
disinfectant. Rinse the wash
head, put the screws back in
and run a test wash.
Take the dispense tubing out
of the pinch valve (far left)
and roll it. Insert it back
into the pinch valve.
Review the plate definition
and ensure all the wash
settings are correct
(especially aspirate height)
If you are using nesting
cups or 100mm tubes where
the fluid is above 75mm in
height, ensure you have
defined a 100mm tube to
use with these samples.
Perform an arm calibration
on the sample tube
positions.
Double check control tubes
as large bubbles may form
across the tube diameter and
interfere with the liquid
level sensing mechanism.
Calibrate the control tube
locations using the arm
calibration software (DS2
Tool box)
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Symptom
Pipetting and Liquid Level
Detection Errors
System is not pipetting
reagents correctly

Possible Causes
An incorrect tube is being
used.

Too many bubbles in the
reagent
System reagent tube
locations are out of
calibration
Reader Errors
Prior to reading the plate, an
error appears stating that the
system failed the sanity
check

The filter wheel or lamp is
dusty
The 405nm filter is dirty

The 405nm filter is
degraded

Prior to reading the plate,
you receive a “Channel
Variation Error”

The lamp is misaligned or
the reader is not functioning
properly
Fluid has spilled on the
reader optics or the reader
optics are dirty.
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Resolution
If a small reagent tube is
being used in place of a
large reagent tube, the
system could aspirate
insufficient fluid or air.
Make sure the customer is
loading the bottle type
requested by the system.
Large bubbles will be
detected during liquid level
sensing. Ensure fluids have
no bubbles when loading.
Calibrate the reagent tube
locations using the arm
calibration software (DS2
Tool box).
Remove the cover from the
filter wheel and blow
compressed air into the
reader optics area.
Remove the 405 filter and
clean it with lens paper.
Reinsert the filter into
location 1 in the filter
wheel.
Request a replacement
405nm filter.
Requires a service call.
Power down the DS2 and
clean the upper and lower
reader optics located
underneath the sample tip
locations. Allow the optics
to dry, turn on the DS2 and
the software. Ensure the
system self test and a read
only assay perform with no
errors.
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Symptom
Reader Errors
The system fails self-test at
the reader module.

Possible Causes
The filter wheel or lamp is
dusty
The 405nm filter is dirty

The 405nm filter is
degraded
The filters are inserted
improperly
The lamp is burned out

Vacuum Sensor Errors
The system gives a vacuum
sensor error during self-test
or prior to washing a plate

Plate Carrier Errors
The plate carrier has
become stuck inside the
DS2.
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The lamp is misaligned or
the reader is not functioning

Resolution
Remove the cover from the
filter wheel and blow
compressed air into the
reader optics area.
Remove the 405nm filter
and clean it with lens paper.
Reinsert the filter into
location 1 in the filter
wheel.
Replace the 405nm filter
Check that the filters are
securely held in place
Look at the back of the
instrument during the self
test. You should be able to
see light coming from the
filter wheel area. If you do
not see any light, the bulb is
burned out. Replacement
requires a service call.
Requires a service call.

Waste bottle cap is not on
tight enough

Make sure the cap is tight,
without over tightening.

Waste bottle cap is cracked
or broken

Inspect the waste bottle cap
for cracks. Replace the cap
if you notice damage.
Requires a service call.

Faulty Vacuum pump or
holes/cracks in the system
tubing.
The plate was not inserted
into the plate carrier
properly.
The plate strips were not
pressed all the way down in
the plate frame.

Remove the 3 screws
holding the metal panel on
the left side of the pipetting
area. Carefully use the belts
underneath the metal panel
to pull the plate carrier out.
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Symptom
Possible Causes
Assay and Database Errors
The assay has the same
The assay file or the
error message at the same
database has become
point in the assay every time corrupted.
it is run.

Resolution
Restore an old database
Export the assay files and
any report files you would
like to keep and then create
a new database. Re-import
desired assays and data files.
Rewrite the assay.

8.7 Requesting Service
If the DS2 needs service, contact the vendor from whom the system was purchased or
contracted for. The Vendor will troubleshoot, assess the situation, and work with Dynex to
find a solution to the service issue.
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8.8 Limited Warranty
8.8.1 Warranty and Special Provisions
DYNEX TECHNOLOGIES products are fully guaranteed for one year against defects in
parts, materials, and workmanship. Defective parts and materials will be replaced or, at the
discretion of DYNEX TECHNOLOGIES, repaired at no charge for a period of one year and
labor required for such replacement or repair will be provided at no charge for a period of one
year, provided that the products are utilized and maintained in accordance with the
instructions in the applicable operating and servicing manual, and provided further that the
products have not, as determined solely by DYNEX TECHNOLOGIES, been subject to
misuse or abuse by the Customer or other parties unrelated to DYNEX TECHNOLOGIES.
DYNEX TECHNOLOGIES makes no warranty, expressed or implied, as to the fitness of any
product for any particular purposes other than those purposes described in the applicable
operating and servicing manual, nor does DYNEX TECHNOLOGIES make any other
warranty, whether expressed or implied, including merchantability, other than those appearing
on the face hereof. Where DYNEX TECHNOLOGIES guarantees any product, whether under
this Warranty or as a matter of law, and there is a breach of such guarantee, the Customer’s
only and exclusive remedy shall be the replacement or repair of defective parts and materials,
as described above. This shall be the limit of DYNEX TECHNOLOGIES liability.
Furthermore, DYNEX TECHNOLOGIES shall not be liable for incidental or consequential
damages. Failure of the Customer to notify DYNEX TECHNOLOGIES of a claimed defect
by registered mail within thirty days of the discovery thereof shall constitute a waiver of any
claim for breach of warranty.
When a product is required by DYNEX TECHNOLOGIES to be installed by a DYNEX
TECHNOLOGIES engineer or technician, the period of this Warranty shall begin on the date
of such installation, provided, however, that any use of the product prior to such installation
shall, at the sole election of DYNEX TECHNOLOGIES, void this Warranty. When
installation by DYNEX TECHNOLOGIES personnel is not required, the period of this
Warranty shall begin on the date of shipment from DYNEX TECHNOLOGIES. The period of
this Warranty shall begin as described above whether or not the product has been installed or
shipped pursuant to a purchase order, and any trial period shall be deducted from the
Warranty period that would otherwise apply under a subsequent placed purchase order for that
product.
Limitation of Liability. Notwithstanding anything to the contrary contained herein, the
liability of SELLER (whether by reason of breach of warranty, breach of contract, tort, or
otherwise), including without limitation under any indemnification provision contained
herein, shall be limited to replacement of goods returned to DYNEX TECHNOLOGIES
which are shown to DYNEX TECHNOLOGIES reasonable satisfaction to have been
nonconforming or to refund the purchase price, or, if not paid, to a credit amount of the
purchase price therefore.
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THE FOREGOING WARRANTIES ARE EXCLUSIVE AND ARE GIVEN AND
ACCEPTED IN LIEU OF ANY AND ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRANTY OF
MERCHANTABILITY AND THE IMPLIED WARRANTY OF FITNESS FOR A
PARTICULAR PURPOSE. NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR
ANY INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES.
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8.9 DYNEX Technologies Contact Information
DYNEX Technologies, Inc.
14340 Sullyfield Circle
Chantilly, VA 20151-1621
Tel: 703 631-7800
800 288-2354
Fax: 703 631-7816
Email: customerservice@dynextechnologies.com
techservice@dynextechnologies.com
www.dynextechnologies.com
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Appendix A Arm Calibration
The Arm Calibration Tool is only available if the DS2 Toolbox plug-in software has been
installed. Arm Calibration should only be performed by a trained technician.
1. Power on the DS2.
2. Double click the DS2 Toolbox icon or select the program using Start>All
Programs>Dynex Technologies>DS-Matrix>Tools>DS2 Toolbox.
3. The DS2 Toolbox main screen will open. Select the Arm Tools menu and then select
Calibrate Arm. The DS2 Arm Calibration Wizard screen appears with a window
instructing the user that a Calibration Tool, a Dynex Microtiter plate, and a black Delrin
stepped collar will be needed to complete this procedure.
4. Insert all five Sample Racks and both Reagent Racks into the rack carriers.
5. The brass Calibration Tool should not be on the spigot. Detach and remove the brass
calibration tool if it is attached to the spigot, then click Next.

Consumables Rack Position
1. Insert the spigot into the rear hole located on the top edge of the consumables rack
between the sample (blue) tip and deep well strip areas. On the dialog, click “Get
Values” for the frame marked Rear Consumables Hole. Values will appear in the
X,Y,Z boxes (Figure A-1).

Figure A-1: Arm Calibration Tool Software
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Sample
Tip
Boxes

Rear
Reader

Hole

Cover
Handle
Front
Hole
Front
Hole

Front
Front
Hole
Hole

Figure A-2: Consumables Rack and Reader Cover Positions
2. Move the spigot to the front hole of the tips rack top edge. Click Get Values in the Front
Consumables Hole frame. Values will appear in the X, Y, Z boxes and click Next to
continue.

Reader Cover Positions
1. Insert the Spigot into the hole in the top of the handle on the Reader Cover. Open the
reader cover and click Get Values.
2. Close the reader cover with the spigot pin still inserted in the handle. Click Get Values
and then click Next.
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Sample Tip Rack Positions
1. Take the tip out of the reader cover hole and gently move the arm up and back to home
position. Load a box of blue sample tips into the sample tip rack. Load clear reagent tips
into the reagent tip racks.
2. Place the spigot fully into the tip marked Datum in Rack 1 (rear sample tip rack) as
shown in Figure A-3. Ensure the spigot is securely inserted into the tip and click Get
Values. If after calibration tips are falling off the spigot during the assay, the spigot was
not inserted into the tip securely enough.
Y Right

Datum

Rack 1

X Bottom

Rack 2

Figure A-3: Sample Tip Rack Positions
3. Repeat step 10 for the tip locations marked “Y Right” and “X Bottom” after reinserting the
spigot into the appropriate tips as indicated by the black circles in Figure A-4.
4. Repeat the entire procedure for Rack 2 (front sample tip rack). Click Next.
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Reagent Tip Rack Positions
1. Ensure clear reagent tips are loaded into both racks in the positions shown in the
following illustration.

Datum

Y Right

X Bottom

Rack 1
Rack 2

Figure A-4: Reagent Tip Rack Positions
2. Insert the spigot fully into the tips located in the reagent tip locations indicated in Figure
A-5. Click Get Values for the frames marked “Datum”, “Y Right” and “X Bottom” for both
sample racks. If reagent tips are falling off the spigot during an assay, the spigot was not
inserted securely enough into the tips during calibration. Click Next.

Barcode Reader Position
1. Ensure there is a Barcode Reader installed on the DS2. If there is no barcode reader,
skip this step.
2. Move the Barcode Reader to the far left position until it clicks into its home position. Insert
the Spigot fully into the Barcode Reader hole. Do not force the spigot or compress the
spring. Click Get Values in the frame labeled Barcode Position and then click Next.
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Barcode
Hole

Wash Head
Waste Hole
DS2 Front Left

Figure A-5: Barcode Reader, Tip Waste, and Wash Head Positions

Tip Waste Hole Position
1. Mount a clear reagent tip on the end of the Spigot. Move the Spigot and tip to the Waste
Hole. Center the tip over the hole. Push the spigot down until the pins are as far down as
possible without engaging the spring/eject mechanism in the spigot. If the spigot is not
pushed down far enough, the tips will fail to eject while running an assay.
2. Click Get Values for the frame marked Waste Position. Remove the reagent tip and
click Next.

Washer Pickup Position
1. Insert the spigot fully into the wash head assembly. Engage and latch the pins on the
Spigot into the catches on the wash head assembly. Click Get Values in the Washer
Pickup frame. Remove the Wash Head assembly from the Spigot and click Next.
2. A message dialog box will be presented which invites the user to save or to cancel the
calibrations done so far. Ensure that the calibration tool is not present on the spigot and
click Next to save the values and initiate a self-test.
3. The DS2 will home the arm.

Washer with Microplate Positions
1. Manually open the Reader Cover. Click Present Upper Plate Carrier. Insert a standard
microplate into the plate carrier.
2. Engage and latch the Wash Head Assembly with the spigot. Be careful not to compress
the wash head.
3. Center the long aspirate pins in the wells in Column 1. Click Get Values for the frame
marked Upper Plate Datum.
4. Center the aspirate pins in the wells in Column 12. Click Get Values for the frame
marked Upper Plate Y Right.
5. Move the Spigot with the Wash Head Assembly attached back to the home position. Click
Present Lower Plate Carrier. Insert a standard microplate into the plate carrier. Repeat
steps 2 and 3 to Get Values for Columns 1 and 12 for the lower plate carrier.
6. Park the Wash Head Assembly in its carrier, remove it from the Spigot and click Next.
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Calibration Tool
Holding Screw

Flat Side

Figure A-6: Calibration Tool
1. Mount the brass Calibration Tool onto the Spigot. The flat sides of the calibration tool
must be to the left and right on the Spigot. Use a hex wrench to tighten the Holding
Screw to hold the Calibration Tool in place. Ensure that the Calibration Tool is pushed up
to the lip on the spigot. There should be no visible space between the lip of the spigot
and the Calibration tool. Click Next.

Plate Carrier Positions
1. Click Present Upper Plate Carrier, and follow the prompts to clear the arm and insert a
plate.
2. Insert the Calibration Tool into well A1 and click Get Values.
3. Insert the Calibration Tool into well A12, click Get Values and Repeat using well H1.
4. Move the Spigot and the calibration tool free of the plate carriers. Click Present Lower
Plate Carrier, and follow the prompts to clear the arm and insert a plate.
5. Repeat Get Values for wells A1, A12 and H1 for the lower plate carrier and click Next.
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Sample Rack Positions
Rack 1
Datum
st
1 Position

Rack 2
2

Y Right
Position

nd

X Bottom
rd
3 Position

Figure A-7: Sample Rack Positions
1. Insert the Calibration Tool fully into Sample Tube position 1 in Rack 1. There should be
no sample tube in the rack and the Tool should go all the way down to the bottom of the
sample rack. Click Get Values for the Datum position. Repeat for the Y and X positions.
(the Y-position is the first sample tube location on Rack 5; the X-position is the last
sample tube location on Rack 1) and click Next.
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Reagents Rack Positions
Rack 1
Datum
st
1 Position

X Bottom
rd
3 Position

Rack 2
2

Y Right
Position

nd

Delrin
Collar

Figure A-8: Reagents Rack Positions
1. Put the black Delrin Collar firmly into position 1 on the large tube Reagent Rack. There
should not be a reagent tube in this location.
2. Insert the Calibration Tool into the collar as far as it will go and click Get Values.
3. Repeat the procedure in steps 1 in the Sample Rack Position test and step 1 in the
Reagents Rack Position test with the first tube position on Rack 2 (Y-Right position) and
click Get Values.
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4. Repeat the procedure in step 1 in the Sample Rack position test and step 1 in the
Reagents Rack Positions test (above) with the last small reagent tube position on Rack 1
(X-Bottom position), click Get Values and click Next.

Control Rack Positions
1. There should be no tubes in the control racks. The Delrin Collar is no longer needed for
calibration and should be stored.

Datum
st
1 Position

2

Y Right
Position

nd

X Bottom
rd
3 Position
Rack 1 Rack 2

Figure A-9: Control Rack Positions
2. Insert the Calibration Tool into the bottom of Datum position on Control Rack 1, Click Get
Values, and repeat the procedure for Y- right and X- bottom positions as shown in Figure
A-9.
3. Repeat the procedure for all three positions on Control Rack 2 and click Next.

Calibration Finished
1. Remove the Calibration Tool from the Spigot by loosening the small holding screw using
a Hex wrench.
2. The calibration is complete. To save all settings, click OK, otherwise click Cancel, which
will revert the settings back to the original values.
3. The DS2 will return the Spigot to home position, and move the plate carriers into position.
4. Select to test for wash head detection.
5. The DS2 will home the arm.
6. Click Exit.
DS2® System Operator’s Manual

185

Appendix A Arm Calibration

This page intentionally left blank.

186

DS2® System Operator’s Manual

Appendix B Labware Specifications

Appendix B Labware Specifications
B.1

Specifications

Type

Max Volume
mL

Height mm

Controls &
Standards
Vial

2000

44.45

8.69

10.3

V

Deep Well
Strip

2000

39.8

7.4

8

V

Large
Reagent
Tube

25000

89.2

22.45

25.4

V

Small
Reagent
Tube

15000

75.9

17.6

20.5

V

Sarstedt
Monovette

10000

92

14.41

16

Flat

12x75
Sample
Test Tube

4000

74.4

9.7

11.9

U

B.2

Internal
Diameter
mm

External
Diameter
mm

Bottom
Shape

Consumables Ordering Information

Item Number

Description

Unit

65910

Blue Sample Tips, 300 µL, 108/box

4 box pack

65921

White Reagent Pipette Tips, 108/box

4 box pack

62910

Deep Well Strips, 250/box

Box

62920

Reagent Tubes, 25 mL, 10/pack

Pack

62930

Small Reagent Tubes, 15 mL, 10/pack

Pack

65940

Control/Standards Vials w. Caps, 33/pack

Pack

394000100

Purge Tray, Microplate Form

3 Pack
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B.3
Item Number

Microplate Ordering Information
Description
®

Quantity / Box

1000

Immulon Medium binding, untreated
polystyrene, 96-well flat bottom
immunoassay plates

40

1010

Immulon® 2HB, High binding, treated
polystyrene, 96-well flat-bottom
immunoassay plates

40

1011

Immulon® 2HB, High binding, treated
polystyrene, 96-well “U”-bottom plates

40
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Appendix C Curve Fit Equations
DS-Matrix allows the user to select from nine mathematical relationships to determine the
concentration of the compound of interest. In this appendix, each of the curve fits is defined.

C.1

Linear Regression

A Linear Regression is used to put a "best fit" straight line through a set of data points.
Equation C-1 describes a linear relationship between the measured variable and the
concentration of the compound of interest:
Y = mX + b
where: m = the slope
b = the y-intercept defining the line
X = the value for the concentration
Y = the value for measured variable (O.D.)

C-1

m = Nxiyi -xiyi
Nxi2-_(xi)2

C-2

b = Ymean – m (Xmean)

C-3

R = (Nxiyi -xiyi)2
(Nxi2 (xi)2)(Nyi2 (yi)2)

C-4

The linear regression formulae for determining the best straight line through a series of data
points are provided in Equations C-2 and C-3:

The linear regression coefficient, R, is defined by Equation C-4:

The linear correlation coefficient (R) is used to determine how well the line fits through the
points of the graph. Since the linear correlation coefficient can be either positive or negative,
the value of R2 is normally reported. When comparing two sets of data (fits), the fit with the
larger value for R2 is a better fit for the data set; if R 2 =1, all data points lie along the line of
best fit and if R2=0, the data points are highly scattered and there is a poor correlation.
Once the linear relationship best fit has been established for a set of known standards, the
concentration of an unknown sample can be determined via equation C-1.
An example of a linear relationship is presented in Figure C-1.
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A
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Concentration

Absorbance

Figure C-1: Linear Regression Fit

Concentration

Figure C-2: Polygon Fit

C.2

Polygon Fit

A Polygon Fit of the data involves joining successive data points using straight lines in a
connect-the-dots fashion as shown in Figure C-2.
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C.3

Quadratic, Cubic and Quartic Regression

Polynomial regressions are similar to a linear regression (equation C-1), but use quadratic,
cubic and quartic equations to relate the observed OD to the concentration.
Equation C-5 is a quadratic equation, Equation C-6 is a cubic equation, and Equation C-7
is a quartic equation.
Quadratic Equation: Y = a +bX + cX 2

C-5

Cubic Equation:

Y = a +bX + cX 2+ dX 3

C-6

Quartic Equation:

Y = a +bX + cX 2+ dX 3+ eX4

C-7

The procedures used to fit these functions to experimental data are similar to that for linear
regression and have a similar mathematical derivation. A polynomial regression tends to
minimize the deviations of the data points from the polynomial equation. The squaring
(cubing, etc.) of the deviations tends to minimize them since positive and negative deviations
tend to cancel out.
The regression coefficient is handled in a similar manner as with a linear relationship. When
R2 = 1, all the data points have been fitted to the curve, when R2 = 0, the data points are
scattered.

Absorbance

Examples of Quadratic and Quartic fits are shown in Figure C-3 and C-4 respectively.

Concentration

Figure C-3: Quadratic Fit
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Figure C-4: Quartic Fit
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C.4

Cubic Spline Curve Fitting

When a Cubic Spline Curve fit is used, a curve is passed through all the data points and a
smoothing function is applied. Equations C-8 to C-10 are then used to determine the
concentration of the sample.
C-8

C-9
C-10

The Cubic Spline Curve Fit is not a best fit algorithm as it assumes that each data point is
correct. If the data is erratic, if it is known that the data has significant errors or if the
concentration/absorbance has many inflection points, this method can lead to significant
errors in the reported concentration.

Absorbance

At high concentrations, the Cubic Spline Curve Fit may break up (Figure C-5). In some cases,
a semi-log or log-log axis (instead of a linear fit) will improve the quality of the data.

Concentration

Figure C-5: Cubic Spline Curve Fit
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C.5

Akima Fit

Absorbance

The Akima fit constructs a smooth curve through the data points. The fitted curve appears
smooth and approximates a manually drawn curve (Figure C-6).

Concentration

Figure C-6: Akima Fit

The Akima Curve Fit involves applying a set of polynomials to the data points, which
determines the slope of the curve at each point .The Akima Fit is based on the assumption that
each data point is determined by five points, the point of interest and two points on either side
of it.
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C.6

Extrapolation of Non-Linear Curves

In many instances, a data point is observed outside the range of the curve that is used to
determine the concentration. The analyst should note that some curve fit functions may not
behave as expected if they are extrapolated beyond the range defined by the data points.

Absorbance

For example, the readings for a set of Standards increase in a non-linear fashion with
increasing concentration for a given test (right side of curve in Figure C-7) and the user
determines that a quadratic curve fit might give the best fit for such data. However, at
concentrations lower than the concentration of the lowest Standard, the curve may turn
sharply upwards as shown in the left side of the curve.

Concentration

Figure C-7: Non-Linear Curve Fit
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C.7

Sigmoid Fit

Absorbance

Many immunoassays are characterized by an S-shaped or sigmoid curve fit (Figure C-8).

Concentration

Figure C-8: Sigmoid Curve

The sigmoid curve is described by equation C-11:
C-11
where: a is the minimum response
b is the shape factor (determines the gradient of the curve)
c is the response midway between the maximum (d) and the minimum
response
d is the maximum response

The above definition assumes that b has a positive value. If b is negative, the definition of
parameters a and d are reversed.
Matrix uses an algorithm for estimating the four parameters and determining the best fit for
the sigmoid curve. The curve requires at least four standards (data points), one for each of the
four parameters. It is recommended that at least eight Standards are defined on a plate to
ensure satisfactory statistical significance.
The Sigmoid Curve Fit algorithm is iterative, requiring many complex calculations. Matrix
may take some time to process the results. If the curve cannot be drawn or data cannot be
processed, a Windows® “Illegal Operation – Shut Down” error message will occur. If this
happens, examine your data carefully to determine if the number of Standards should be
altered or a different type of curve fit should be used.
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C.8

Log – Logit Curve Fit

The Log – Logit Curve Fit is the Rodbard’s Four Parameter fit, similar to the Sigmoidal fit.
It also uses auto- or manually-assigned parameters to calculate the graph.
Standard curves commonly display a pronounced sigmoidal shape when plotted on an OD
versus log dilution scale. The logit function adopts the same general shape and is a reasonable
relationship to use in modeling standard curves. It is described as:
OD = d + {(a - d)/[1 + (dilution/c)b]}
Parameters a and d represent the upper and lower asymptotes, respectively, of the curve and
correspond to the theoretical OD of the assay at infinite and zero concentrations, respectively.
The value c is the dilution associated with the point of symmetry of the sigmoid and is located
at the midpoint of the assay found at the inflection point of the curve. The value b is a
curvature parameter and is related to the slope of the curve.
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C.9

Using Logarithmic Axes Fitting

In most instances, linear scales are used to plot the concentration (X axis) and the OD
measured variable (Y axis). Alternatively, a semi-log fit or a log-log axes fit can be used. The
following example equations relate to linear regression fits, but Semi-Log and Log-Log Axes
fits may be used with all the other selectable curve fits.

C.9.1

Semi-Log Fit

When a semi-log fit is used, the X axis presents log (power of 10) concentration. To obtain
the concentration of a sample, equation C-12 is used.
Concentration = antilog (y-c)/m

C.9.2

C-12

Log-Log Fit

When a log-log fit is used, the X axis represents the log of the concentration (concentrations
in powers of 10) and the Y axis represents log of the OD (measured variable). To obtain the
concentration of a sample, equation C-13 is used.
antilog Concentration = antilog (y-c)/m
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D.1

Entries for Quality Control Equations

SYMBOL

FUNCTION

0-9

Numeric entry

+

Addition

Standard Arithmetic operator

-

Subtraction

Standard Arithmetic operator

/

Divide

Standard Arithmetic operator

*

Multiplication

Standard Arithmetic operator

**

To the power of

Standard Arithmetic operator

((( )))

Parenthesis

Max 6 levels

Log

Base 10 logarithm

Ln

Natural logarithm

Exp

Inverse natural
logarithm

CV(well type)

Coefficient of variation

SD(well type)

Standard deviation

Median©

Median

Custom Variable

COMMENT

If all values in a group are listed,
the median is the value in the
middle of the list. If the list
contains an even number of
values, the median if the mean of
the middle two. The group of
values may be a well type, or a
sample, if it contains replicates.
Can be used to prompt for entry
of a variable number at run time

>

Greater than

<

Less than

>=

Greater than or equal to

<=

Less than or equal to

==

Must be equal to

MIN or MAX

Represents the highest or lowest
value on the plate or within a
group of values. The group may
be a well type or a sample if it
contains replicates.
EX: MIN(PC)= the lowest value
of all the Positive Control
samples
MIN= the lowest value on the
plate
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SYMBOL

FUNCTION

COMMENT

T,T1,T1.1

Referenced Well Types

T represents the mean of all the
Test values
T1 represents the mean of the
replicates of Test1
T1.1 is the value of the first
replicate of Test 1
T1.2 is the value of the second
re[plicate if Test 1

I

Each sample of a well
type

EX: 0.74*C<Ci<1.25*C means
each Control sample must be
within 25% of the mean of the
Controls or that well is removed
from the calculations. Should be
accompanied by a Valid
statement
A Valid( ) expression indicates
that a specified number of values
within a group must pass other
QC equations otherwise the data
fails QC. The group of values
may be a Well Type or a sample
with replicates.

Valid( )

EX: valid(PC)>=3 means the
number of valid Positive Controls
must be greater than or equal to
three or QC is failed.
=

Assignment

An assignment expression
indicates that, depending on
certain criteria, a well type,
sample or replicate should be
assigned a value.
EX: If NCi<0.0 then NCi=0.0
Thus, if every NC value is less
than 0.0, then let every NC be
assigned a value of 0.0

If {condition}
then
{expression}
else
{expression}

Conditional
Requirement

EX: If PC<0.2 then NC>0.5 else
NC>0.1
Means If the average PC value is
less than 0.2 then the average
NC value must be more than 0.5
else the average NC value must
be more than 0.1.
If these conditions are not met,
the data fails QC
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SYMBOL

FUNCTION

COMMENT

Verify (value,
limit, mode)

Expression

Indicates that a specified number
of values within a group must be
within specified limits or the data
fails QC.
Value represents a well type
checked for the number of
verified samples within that
group or number of verified
replicates within a specified
sample.
Limit determines the range into
which values must fall in order to
be verified.
A limit may be a number.
EX: If the value is PC, the mode
is 0 and the limit is 0.2, so that
every PC sample is within 0.2 of
the average of all the group
values.
A limit may be a percentage.
EX: If the value is PC, the mode
is 0 and the limit is 20%, then
every PC sample must be within
20% of the average of all the
group values.
A Limit may be a standard
deviation.
EX: If the value is PC, the mode
is 0 and the limit is 1.5SD, then
the standard deviation of all the
PC samples must be within 1.5
SD.
EX: Verify(T,10%,2>=3
Means the number of verified
Test samples must be greater
than or equal to 3. A verified Test
sample falls within 10% of the
mean of all other Test samples.
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SYMBOL

FUNCTION

COMMENT

Following Threshold
POS / NEG

Well Label

The user can require that a
specific (default or user defined)
threshold Well Type be labeled
All samples within the Well Type
must fall into the required result
range or the Well Type will fail
QC and a warning will be
displayed in the results.

Following Curve Fit
Min R-squared
Min Slope
Max Slope
Min Y-Intercept
Max Y-intercept

R-squared may be used to
determine how closely the
standards fit a linear regression
curve fit. QC may fail if they Rsquared is below a specified
value.
Min slope / Max slope may be
used to define the change in Y
over the change in X within a
certain range
Min Y-intercept / Max Y-intercept
may be used to keep the data on
the y-axis in the correct place or
else the curve fit fails, meaning
there is not enough
discrimination in response.
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D.2

Entries for Ratio and Threshold Equations

SYMBOL

FUNCTION

COMMENT

Sample

Value of every well on
the plate

Represents the value of every
well on the plate regardless of
Well Type
EX: sample/10

0-9

Numeric entry

+

Addition

Standard arithmetic operator

-

Subtraction

Standard arithmetic operator

/

Divide

Standard arithmetic operator

*

Multiplication

Standard arithmetic operator

**

To the power of

Standard arithmetic operator

((( )))

Parenthesis

Max 6 levels

Log

Base 10 logarithm

Ln

Natural logarithm

Exp

Inverse natural
logarithm

MIN or MAX

Represents the highest or lowest
value on the plate or within a
group of values. The group may
be a well type or a sample if it
contains replicates.
EX: MIN(PC)= the lowest value
of all the Positive Control
samples
MIN= the lowest value on the
plate

CV(well type)

Coefficient of variation

SD(well type)

Standard deviation

Median( )

Median

If all values in a group are listed,
the median is the value in the
middle of the list. If the list
contains an even number of
values, the median if the mean of
the middle two. The group of
values may be a well type, or a
sample, if it contains replicates.

Custom Variable

User defined variable

VariableX

Different variable to use each
time run is done
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Appendix E Tube Definition
Custom bottle definitions can be created in the DS-Matrix software by following the
instructions below. A ruler capable of measuring in mm increments or a micrometer is
required for accurate measurements. A bottle definition may be entered into the bottle
database, but it may not be used until it has been calibrated.
Calibration of a bottle (referred to as Fluid Level Tracking in the DS-Matrix software)
requires an accurate laboratory grade balance with precision to 1mg (0.001gm). A custom
bottle definition must be calibrated before it will appear for use in drop down lists in the DSMatrix software. Newly defined and calibrated bottles should be tested and validated before
incorporating them into customer assays.
Warning: Improper bottle definition and calibration can lead to incorrect
results!

1. Select the Tools menu.
2. Select Database Maintenance… from the drop down menu.
3. Select Bottle Type as the Database Type.
4. Click the Add Consumable button.

Add Consumable Button

Figure E-1: Add Consumable Button
5. Enter a name for the new tube and click OK.
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Figure E-2: Enter tube name
6. In the Bottle window enter in the following information:

Figure E-3: Bottle Definition window
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a. Description: Description of the bottle (optional)
b. Type: Select the tube type that best corresponds to the use of the new tube (For
example: if the tube is used to hold test specimens, select Test Sample).
c. Use a micrometer (preferred) or ruler to measure the tube:
i.

Height: enter tube height (bottom to top) in mm.

ii. Internal Diameter: enter the diameter of the inside of the tube in mm
(represented by the dotted line).
Inside of tube
Outside of tube

Figure E-4: Internal tube diameter
iii. External Diameter: enter the diameter of the tube in mm (represented by
the dotted line).

Figure E-5: External tube diameter
iv. Tip Submersion: enter the number of mm the tip should submerge below
the surface of the liquid while aspirating.
v. Maximum usable volume: Enter the maximum useable volume in the tube
in µL. The higher the maximum useable volume, the greater the dead
volume required for the tube.
vi. Outside bottom thickness and Inside Bottom Height: Enter both of these
values in mm. Outside bottom thickness is the distance from where the
fluid holding portion of the tube ends to the physical bottom of the tube.
Inside Bottom Height is the distance from where the fluid holding portion of
the tube begins to where the straight sides of the inside of the tube begin.
See diagram below:

Inside Bottom Height

Outside Bottom Thickness

Figure E-6: Outside Bottom Thickness and Inside Bottom Height
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vii. Select a bottom shape from the drop down list.
viii. Click Save to save the settings.
7. Click the Exit button to leave the Database Maintenance window.

Exit Button

Figure E-7: Exiting the Database Maintenance Window
8. Select the Tools menu.
9. Select Fluid Level Tracking.
10. Select the newly created tube from the drop down list under Selected Bottle Type.
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Figure E-8: Fluid Level Tracking Window
11. Follow the directions in the message center to calibrate the new tube. Once the tube has
been calibrated using fluid level tracking, it is available for use on the DS2. Do not use a
new tube without performing fluid level tracking.
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Appendix F Plate Definition
Custom plate definitions can be created in the DS-Matrix software by following the
instructions below. A ruler capable of measuring in mm increments or a micrometer is
required for accurate measurements.
Warning: Improper plate definition can lead to incorrect results!

1. Select the Tools menu.
2. Select Database Maintenance… from the drop down menu.
3. Select Plate Type as the Database Type.
4. Click the Add Consumable button:

Add Consumable Button

Figure F-1: Add Consumable button
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5. Enter a name for the new plate and click OK.

Figure F-2: Entering a new plate name
6. In the Plate window, enter the following information:

Figure F-3: Plate Definition Window
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a. Description: enter a description to clarify the plate name (Optional)
b. In the Plate Properties area:

Figure F-4: Plate Properties Definition
i.

Select Microtiter as the plate Type.

ii. Enter the Number of Rows the plate contains.
iii. Enter the Number of Columns the plate contains.
iv. Enter the Length (longer side) of the plate in mm
v. Enter the Width (shorter side) of the plate in mm
vi. Enter the Height of the plate in mm
Columns

Width

Rows

Length
Height

Figure F-5: Diagram Representation of Plate Properties
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c. In the Well Properties area:

Figure F-6: Well properties definition
i.

Enter the well Height. The well height is measured from the outside of the
bottom of the well to the outside of the top of the well.

ii. Enter the Internal Diameter. The interior diameter is shown by the dotted
line in the figure below. Interior diameter is measured near the top of the
well.
Interior of well

Outside edge of well

Figure F-7: Internal diameter of well
iii. Enter the Bottom Diameter. The bottom diameter is the diameter of the
well at the point closest to the bottom of the well.
iv. Enter the Maximum Usable Volume. This is the volume of fluid that can
safely be dispensed to the well without causing the well to overflow.
v. Enter the Outside Bottom Thickness. The outside bottom thickness is
equal to the internal well height minus the total well height (see step 6.c.i
above for total well height).
vi. Enter the Bottom Shape.
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vii. Enter the Inside Bottom Height. For flat bottom shaped microtiter plates,
the Inside Bottom Height is always equal to zero. For “U” and “V” bottom
plates, the inside bottom height is equal to the distance between the
lowest point in the well and the point at which the sides of the well are
straight.

Inside Bottom Height for
a V-shaped well bottom

Figure F-8: Diagram of Inside Bottom Height
d. In the Washer Properties area:

Figure F-9: Washer Properties Window



Note: Insert a plate into the lower plate carrier. Clicking the Show button with a
plate in the plate carrier moves the wash head assembly to the position associated
with the Show button.
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i.

Enter the Dispense Height. The Dispense Height is the level at which the
wash head will dispense fluid into the well. At the Dispense Height, the
aspirate pins (long pins) on the wash head should be just slightly higher
than the top of the well (approximately 1 mm).

ii. Enter the Aspirate Height. The aspirate height is positions the aspirate
pins just above the bottom of the well. When the Show button is clicked
the aspirate pins should not touch the bottom of the wells.
iii. Enter the Bottom Wash Height. At the correct bottom wash height, the
aspirate pins should be positioned in the approximate center of the well, a
few mm above the aspirate height.
iv. Enter the Top Well Height. At the correct top well height, the aspirate
pins should be exactly even with the top of the well.
v. Enter the Sweep Height. At the correct sweep height, the aspirate pins
should be a millimeter or two higher than the aspiration height. The sweep
height is the height the aspirate pins are lifted up off the bottom of the well
to move to the sweep position. If well bottoms are scratched when
washing the plate, the sweep height must be increased.
vi. Enter the Sweep Stroke. The sweep stroke is the distance the aspirate
pins move from the center of the well when operating in sweep mode or
super sweep mode. The sweep stroke should be adjusted so that
aspiration is optimized without scraping the sides of the wells.
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Absorbance Filter, 50
Absorbance Filter Definitions
Editing, 50
Absorbance Module, 13
Absorbance Module Filter
Replacing, 157
Add Fluids Dialog Box, 81
Adding a Consumable, 36
Akima Fit, 194
Arm Calibration, 177
Aspirate
Operation, 95
Assay Editor, 69
Assay File
Exporting, 51
Importing, 52
Assay Operations
Programming, 78
Assay Parameters
Defining, 69
Assay Program
Saving, 120
Assay Programming, 15
Assay Programming Screen, 79
Assay Title Page, 70
Auto Difference Equations, 118
Auto Recovery
Reset, 54
Automatically save self test report, 45
Average the replicates, 75
Axes Selection, 114

B
Backup Frequency, 46
Bar Codes
Supported, 141
Barcode Scanner, 7
Blanking, 13
Buffer Containers, 10

C
Calculation Options, 113
Calibration
Arm, 177
Barcode Reader Position, 180
Consumables Rack Position, 177
ESP, 60
Reader Cover Positions, 178
Sample Rack Positions, 183, 184, 185
Sample Tip Rack Positions, 179
Tip Waste Hole Position, 181
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Washer Pickup Position, 181
Washer with Microplate Positions, 181, 182
Calibration Tool, 182
Calibrations
Reagent Tip Rack Positions, 180
Checking Consumables Status, 133
Clean
Operation, 95
Cleaning, 156
Cleaning Fluid Container, 11
Clot Detection, 38
Codabar barcode, 44
Computer
Connecting, 25
Specifications, 25
Connecting the Computer System, 25
Constant Timing, 97
Consumables
Loading, 148
Ordering, 187
Consumables Definitions, 15
Consumables Status
Checking, 151
Contact Information, 176
Container C, 11
Create Matrix, 74
Create Table, 74
Creating
Worklist, 121
Creating an Assay, 70
Cubic Regression, 191
Cubic Spline Curve Fitting, 193
Curve Fit Equations, 189
Curve Fit Operation, 110
Curve Fitting
Cubic Spline, 193

D
Data Analysis, 16
Data File
Exporting, 53
Importing, 53
Data Read Limits
Defining, 42
Database Backup Options
Defining, 46
Database Maintenance, 34
Debug Log, 41
Decontamination, 156
Deep Well Strip, 38
Deep-well Strip Dilution, 82
Defining Wells, 71
Desktop
Shortcut, 28
Diluting Samples, 82
Dilution in Deep-Wells, 83
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Dilution Parameters
Setting, 83
Dispense
Operation, 95
Dispense Operation, 80
Dispense Parameters
Defining, 80
DS2 Configuration, 15
DS2 filter wheel, 50
DS2 Online Help, 14
DS-Matrix software, 14
Dual Wavelength Mode, 13
Programming, 101
Duration Learn, 40

E
Electronic Signature Pipetting, 8
e-mail, 48
Enable Boolean Function Assays, 41
Entering Sample IDs
Bar Code, 122
Entering Standard Concentrations, 111
Equation Functions, 199
ESP, 8
ESP Calibration, 60
ESP Plus profile, 89
ESP score, 38
Event Log, 56
Exporting
Assay File, 51
Data File, 53
Extrapolation of Non-Linear Curves, 195

F
Fill
Operation, 95
Filter
Installing, 158
Removing, 157
Fit Selection, 113
Fluid Level Tracking, 63
Calibration, 63
Fluid Level Tracking Calibration Steps, 64
Fluid Volume Levels
Acceptable Error, 38
Fluids Parameters
Defining, 38
Format Type, 74
Functions
Quality Control Programming, 103

G
Generate self test report option, 45
Graphing Options, 115
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H
Header Footer, 76
Help, 14

I
IATA barcode, 44
Importing
Assay File, 52
Data File, 53
Incubate/Shake Operation
Programming, 93
Incubate/Shake Operation Screen, 93
Incubate/Shake Settings, 94
Incubation Chamber, 7
Initial Dilution tab, 85
Initialization, 31
Installation, 21
Introduction, 1

L
Laboratory Information
Defining, 43
Labware Specifications, 187
Levey-Jennings Criteria, 57
Linear Regression, 189
LIS Options
Defining, 47
Log – Logit Curve Fit, 197
Logarithmic Axes Fitting, 198
Log-Log Fit, 198

M
Maintenance, 153
Matrix software, 14
Max post pipette time, 90
Microplate
Ordering, 188
Microplate Dilution, 82
Microplate Incubation Chamber, 7
Microplate Pipetting Template, 70
Microplate Pipetting Template icon, 71
Mix Volume, 38
Modifying the Dilution Ratio
Runtime, 126
Multishot Allowed, 89

N
New Assay
Programming, 69
Non-Linear Curves, 195
Normal Mode, 30
Numeric Options, 75
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Operations Parameters
Defining, 40
Optimizations, 86
Order of Operations in an Assay
Adding, Deleting, Changing, 78
Output to File, 77
Over / Under OD Conversion, 42
Overview, 1

P
Packing List, 21
Pipette Module, 7
Pipette/Mixing tab, 87
Pipetting Operations
Programming, 82
Pipetting Options, 39
Pipetting without Dilution, 89
Plate Definition, 211
Positioning the Instrument, 23
Power Cord, 27
Programming Assay Operations, 78
Purge
Operation, 95

Q
Quadratic Regression, 191
Quality Control Functions, 104
Quality Control Operation
Programming, 102
Quartic Regression, 191

R
Ratio and Threshold Equations
Entries, 203
Ratio Operation
Programming, 105
Read Operation
Programming, 100
Read Operation Parameters Screen, 100
Report, 135
Report Format, 74
Report Format Set-up, 73
Reset
Auto Recovery, 54
Results Flagging, 106, 116
Results Order, 74
Results Reporting, 16
Rodbard’s Four Parameter fit, 197
Run
Starting, 141, 144
Run Report
Generating, 152
Run Status
Monitoring, 133
Runtime Screen, 31
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Safety, 17
Safety Precautions, 18
Sample IDs
Assigning, 122
Sample Tube type, 38
Save All ESP Parameters, 38
Saving an Assay Program, 120
Secondary Dilution tab, 85
Self Test Report Options
Defining, 45
Semi-Log Fit, 198
Send Test E-Mail, 48
Service, 153
Sigmoid Fit, 196
Simulation Mode, 30
Single Wavelength Mode, 13
SMTP Server, 48
Soak
Operation, 95
Software
Installation, 28
Software Description, 14
Software Functions, 15
Specifications, 2
Spreadsheet Operation, 117
Squeeze Template, 41
Starting Run, 144
Starting the Run, 141
Starting the System, 29
Sweep
Operation, 95
Sweep Mode, 98
Symbologies, 44
System Barcodes
Defining, 44
System Configuration, 37
System Configuration Data Read Limits, 42
System Configuration Laboratory Information, 43
System Cover, 5
System Parameters, 33

T
Table Options, 74
Threshold Equations, 109
Threshold Operation, 108
Timeline and Load Wizard, 147
Timeline Toolbar, 31
Timeline View
Run Status, 150
Tracking
Fluid Level, 63
Tube Definition, 205
Tubing
Replacing, 160
Two Stage Deep-well Strip Dilution, 82
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U
Unpacking, 21
Use Check Digit, 44
Use Leading Zero, 44
Use New Tip, 89
User Notification, 48
Configuring, 48

V
Verify Fill Operation
Programming, 91
View / Edit Pipette Order button, 90
View History, 56

W
Warning Labels, 17
Warranty, 174
Wash Buffer Containers, 10
Filling, 142
Wash Head, 9
Wash Head Assembly, 8
Cleaning, 166
Wash Head Cleaning Fluid Container, 11
Wash Operation
Programming, 95
Wash Operation Parameters Screen, 96
Wash Parameters
Setting, 97
Waste Container
Emptying, 143
Waste Containers, 12
Waste Fluid Level Sensor, 12
Well Fill Verify Parameters, 91
Well Type Definitions, 72
Well Type Labels, 73
Worklist, 121
Creating, 121
Scheduling/Accepting, 129
Worklist Creation, 15
Worklist Execution, 16
Workspace Components, 6
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